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Copyright © 2001-2006 PIVTEC GmbH. All Rights reserved worldwide. No part of PIVview 
software or documentation may be reproduced, transmitted, transcribed, disassembled, 
reverse engineered, stored in a retrieval system, or translated in any form without the 
express written permission of PIVTEC GmbH. 

Warranty 
PIVTEC GmbH (PivTec) warrants that the PIVview computer program and documentation will substantially conform to published 
specifications. PIVTEC also warrants that the media (CD-ROM) used to transfer the software is free from defects in material and 
workmanship and that the software is free from substantial programming errors for a period of six (6) months from the date of 
purchase, unless a longer period is required by local law. During this period defective media will be replaced and substantial 
programming errors in the software will be corrected by PIVTEC with no charge. If PIVTEC is unable to replace defective media 
or correct substantial programming errors within sixty (60) days after notification of the defect or error, PIVTEC will refund the 
license fee to the licensee. There are your sole remidies for any breach of warranty. 

Disclaimer of Warranties 
YOU EXPRESSLY ACKNOWLEDGE AND AGREE THAT USE OF THE PIVTEC SOFTWARE IS AT YOUR SOLE RISK AND 
THAT THE ENTIRE RISK AS TO SATISFACTORY QUALITY, PERFORMANCE, ACCURACY AND EFFORT IS WITH YOU. 
EXCEPT FOR THE LIMITED WARRANTY ON MEDIA SET FORTH ABOVE AND TO THE MAXIMUM EXTENT PERMITTED 
BY APPLICABLE LAW, THE PIVTEC SOFTWARE IS PROVIDED „AS IS“, WITH ALL FAULTS AND WITHOUT WARRANTY 
OF ANY KIND, AND PIVTEC HEREBY DISCLAIMS ALL WARRANTIES AND CONDITIONS WITH RESPECT TO THE PIVTEC 
SOFTWARE, EITHER EXPRESS, IMPLIED OR STATUTORY, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 
WARRANTIES AND/OR CONDITIONS OF MERCHANTABILITY, OF SATISFACTORY QUALITY, OF FITNESS FOR A 
PARTICULAR PURPOSE, OF ACCURACY, AND NON-INFRINGEMENT OF THIRD PARTY RIGHTS.  PIVTEC DOES NOT 
WARRANT, THAT THE FUNCTIONS CONTAINED IN THE PIVTEC SOFTWARE WILL MEET YOUR REQUIREMENTS, THAT 
THE OPERATION OF THE PIVTEC SOFTWARE WILL BE UNINTERRUPTED OR ERROR-FREE, OR THAT DEFECTS IN 
THE PIVTEC SOFTWARE WILL BE CORRECTED. NO ORAL OR WRITTEN INFORMATION OR ADVICE GIVEN BY PIVTEC 
OR A PIVTEC AUTHORIZED REPRESENTATIVE SHALL CREATE A WARRANTY.  SHOULD THE PIVTEC SOFTWARE 
PROVE DEFECTIVE, YOU ASSUME THE ENTIRE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.  
SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES OR LIMITATIONS ON APPLICABLE 
STATUTORY RIGHTS OF A CONSUMER, SO THE ABOVE EXCLUSION AND LIMITATIONS MAY NOT APPLY TO YOU. 

Limitation of Liability 
TO THE EXTENT NOT PROHIBITED BY LAW, IN NO EVENT SHALL PIVTEC BE LIABLE FOR PERSONAL INJURY, OR ANY 
INCIDENTAL, SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES WHATSOEVER, INCLUDING, WITHOUT 
LIMITATION, DAMAGES FOR LOSS OF PROFITS, LOSS OF DATA, BUSINESS INTERRUPTION OR ANY OTHER 
COMMERCIAL DAMAGES OR LOSSES, ARISING OUT OF OR RELATED TO YOUR USE OR INABILITY TO USE THE 
PIVTEC SOFTWARE, HOWEVER CAUSED, REGARDLESS OF THE THEORY OF LIABILITY (CONTRACT, TORT OR 
OTHERWISE) AND EVEN IF PIVTEC HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. SOME 
JURISDICTIONS DO NOT ALLOW THE LIMITATION OF LIABILITY FOR PERSONAL INJURY, OR OF INCIDENTAL OR 
CONSEQUENTIAL DAMAGES, SO THIS LIMITATION MAY NOT APPLY TO YOU.  In no event shall PIVTEC‘s total liability to 
you for all damages (other than as may be required by applicable law in cases involving personal injury) exceed the original 
purchase cost of the PIVTEC software.  The foregoing limitations will apply even if the above stated remedy fails of its essential 
purpose. 

PIVTEC RESERVES THE RIGHT TO MAKE CHANGES FROM TIME TO TIME IN THE CONTENTS OF PIVTEC SOFTWARE 
WITHOUT OBLIGATION OF PIVTEC TO NOTIFY YOU AS A LICENSE HOLDER OF SUCH REVISIONS OR CHANGES. 
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Overview of PIVview 
Background 
PIVview is a compact program package for the evaluation of particle image velocimetry (PIV) 
or speckle displacement recordings. Its original and primary intention was to provide a quick-
look data retrieval from PIV recordings. Experience has shown that this quick-look capability 
is essential in the optimization of the acquisition process. 

Features 
During its development PIVview has matured from a simple PIV image probing program to a 
(nearly) complete PIV evaluation package including:  

• advanced processing algorithms: 
- multiple-pass method 
- mulitple-grid (pyramid) method 
- double-correlation method 
- second order, image deformation methods 
- various peak detectors and fitting algorithms)  
- ensemble correlation 

• classical and nonlinear peak detection 
• image pre-processing (various filters, masking)  
• region of interest selection  
• interactive calibration  
• outlier detection and replacement  
• data postprocessing (vorticity, strain)  
• vector and contour display / print capability  
• data export (TecPlot, ASCII and netCDF)  
• PIV data import for further post-processing  
• WYSIWYG export using BMP, PNG, and others  
• batch processing of image and data sequences  
• data set statistics calculation 
• stereo PIV processing capabilities 
• drag-and-drop capabilities 
• mask editing 
• command-line programs 

Since version 2.0 PIVview’s user interface has been making use of the platform-independent 
QT-library (Trolltech, www.trolltech.com) and can be made available on most Unix systems 
(e.g.. Linux, Solaris).  

Upcoming features  
Since PIVview is a continuously evolving program suite; new features and improvements are 
constantly added. PIVTEC is always open to new suggestions and encourages users to 
forward these as well as any bug reports. 

What PIVview is not 
PIVview does not include any form of data acquisition such as PIV camera and laser control, 
experiment synchronization, etc. This guarantees that the program can be operated on any 
PC-system running a 32-bit Windows operating system. 
Also PIVview has no intention of replacing the capabilities of full-featured plotting packages 
such as TecPlot or Origin. The plotting capabilities of PIVview merely provide the user with 
visual feedback of the processing results while also providing the capability of quickly 
obtaining a hardcopy of the calculated data. 



2 PIVview User Manual
 

 

PIVview Versions  
Two versions of PIVview are available: a demo version as well as a licensed version. 
The demo version - downloadable from PIVTEC’s internet server - provides nearly all 
features of the licensed version except for data-export and batch-processing. The demo 
version can be distributed freely and is especially useful for optimizing a PIV experiment or 
for demonstrating the principles of PIV evaluation. 
Full use of all of PIVview‘s features is only possible by obtaining a license through PIVTEC 
GmbH. 

Credits  
PIVview was conceived and is maintained by C. Willert, PIVTEC GmbH, Göttingen 
(Germany), and developed in close cooperation with the PIV-Group of the German 
Aerospace Center (DLR) in Göttingen. 
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System Requirements 
PIVview should run on essentially any of today’s Windows operating systems. 

• 32-bit Microsoft Windows (tested on Windows versions 95, 98, NT4, 2000, XP) 
• Pentium class processor 
• >32 MB of RAM (depending on Windows version) 
• 256-color SVGA or better graphics display 
• hard disk space: 

program executables: ~5 MB 
example files: ~30 MB 
utility programs: ~4 MB 

 
If you merely want to try out PIVview you need not install it on your system. The program can 
be run from the CD-ROM by double clicking the PivView2CDemo.exe file.  

Alternatively PIVview can be installed from the setup CD-ROM in several ways: 

Installation Method A 
1. Put the PIVview CD-ROM into your CD-ROM drive. 
2. In your file browser double click the file  autorun.exe. This starts an installation 

option dialog. 
3. From there the setup procedure can be initiated. Alternatively, the documentation or 

latest release notes can be viewed. 
4. Follow the instructions in the installation program. 

Installation Method B 
1. Put the PIVview CD-ROM into your CD-ROM drive. 
2. From the Windows Start button click Run. 
3. Type the following Run command line: 

D:\PIVVIEW2\SETUP\SETUP.EXE 
(If necessary substitute the appropriate drive letter for your CD-ROM drive in the 
above command.) 

4. Follow the instructions in the installation program. 

What is installed where ? 
By default the PIVview program and its associated files are  installed in the system’s 
Programs or Program Files directory. Other destinations can be chosen during setup. 
All(!) files associated with PIVview are copied into this directory tree, that is, no files are 
copied to the Windows system directories. This also means that the program can be 
removed efficiently by deleting this directory although the system’s uninstall method should 
be preferred. 

Aside from the files, the installation programs installs a few short cuts to the system’s start 
menu.  

PIVview makes extensive use of the Windows registry to store its current configuration 
settings. These are located under: 
\HKEY_LOCAL_MACHINE\Software\PivTec\PIVview2 

Removing PIVview 
The best way to remove PIVview is to use the Uninstaller which is part of the Windows 
operating system (found under Configuration\Software). 
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Alternatively the software is completely removed by deleting the PIVview installation 
directory. This however does not remove the registry entries associated with PIVview. 
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Getting acquainted with PIVview 
The user interface of PIVview is similar to many common Microsoft Windows based 
applications and features: 

- a title bar  
- a menu bar  
- several toolbars 
- a main window to view data (workspace) 
- a status bar 

PIVview is based on a single document software architecure, that is, only one image (pair) 
can be opened by each PIVview instance. If you need to open several PIV images 
simultaneously you need to start several instances of PIVview which can be started through 
the menu option: File/New Window.  (Please note that the settings of last PIVview instance 
closed are stored in the registry.) 

 
Main window of PivView with image pair loaded and interactively sampled interrogation vectors. 
The intensity LUT is displayed on the left. The top-left shows a reference scale vector. 

Title bar 
The title bar displays the file name(s) of currently loaded image or data file(s) and PIVview’s 
current mode of operation (e.g. cross-correlation, autocorrelation or speckle shift mode). 

Menu bar 
The menu bar is used to perform any required operation within PIVview and contains seven 
sub-menus: 

- File for loading images, saving data, setting preferences or exiting the program; 
- Image for basic image display related functions (brightness, look-up tables, zoom, etc.) 

as well as image enhancement; 
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- PIV for performing PIV analysis, defining PIV interrogation parameters or regions of 
interest; 

- Plot for configuration of plotting parameters or exporting a plot of the currently displayed 
data; 

- Windows to activate additional data display windows such as correlation plane, 2-D and 
1-D histograms, or data probing menu; 

- Help to display PIVview version information or  available program options. 

Main window  
Once loaded, PIV images are displayed in the main window. Image pairs are displayed by by 
selecting the brightest pixels from both images.  

The image (pair) can be interactively interrogated at any position using the left mouse button. 
The interrogation parameters for cross-correlation analysis are defined in various setup 
menus. The results of the correlation analysis are displayed in the status bar at the bottom as 
well as in the form of a color-coded vector (defined in the Plot/Vector setup menu).  

Main window - Lookup table 

A lookup table (LUT) is used to convert image intensities to screen intensities or colors. The 
image above shows the currently selected LUT as a vertical bar on the left — in this case a 
linear intensity ramp with 0 (black) at the bottom and 255 (white) at the top.  

The number at the top of the LUT represents the intensity of brightest display pixel. The 
image brightness can be changed by using the menu entries Image/Brigher or 
Image/Darker or the short-cut keys‚ b and d, respectively. Pixel intensities exceeding the 
maximum display intensity are either clipped at the maximum or wrap back to the bottom of 
the LUT (Image/Clipping). 

The display of the LUT can be turned off with the menu option Image/Hide LUT. 

Main Window - Reference Vector  
The reference vector‘s main purpose is to have a visual reference when a complete data set 
is plotted or exported. It‘s magnitude and display is defined via Plot/PlotConfig./Ref.Vector.  

Main Window - Scroll Bars  
The scroll bars on the right side and bottom edge of the main window can be used to pan the 
image to a different viewport if the entire image does not fit into the display window.  

Status Bar  
The status bar generally reports the cursor position in both image units [pixels] as well as 
physical coordinates. Also the image intensity is given. In case of interactive interrogation, 
the correlation result is shown (e.g. position, displacement, velocity, correlation coefficient). 

If the image has been evaluated these fields provide information about the data point closest 
to the cursor.  

 
Note: Many of the toolbar buttons and menu entries only become active if image or data is 
available. 
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The PIVview Menu Entries 
The File Menu  
Evaluation Mode – specifies one of the three PIVview operation modes:  

 Cross-Correlation Mode - the standard mode for PIV analysis based on double-frame, 
single-exposure images (image pairs).  

 Autocorrelation Mode - PIV analysis based on single-frame, double-exposure images 
which are common in photographic PIV.  

 Speckle Displacement Mode - for the analysis of speckle displacement image pairs. This 
mode is similar to the cross-correlation mode but instead of converting the data to 
velocity it is presented as displacements. Also the two required images are loaded 
separately.  

 Preferences – opens a dialog which allows to set a variety of PIVview-global settings such 
as file extensions, default data output, etc. 

 Open image – opens a file dialog for loading a PIV image (pair) or speckle shift image. 

 Open data – opens a file dialog for loading a PIV or speckle shift data set. 

 Save data set – opens a menu with output options to save computed PIV data in a file. The 
Save menu option uses the file title (without extension) to create a name for the output file 
and places it in the same directory with the original image. With the Save as option the user 
can define the name and destination directory of the output file. 

 
Create Tecplot Data – to save the processed data set in a format compatible with Tecplot. 
Style files for Tecplot are also generated.  

 Parameters... (Load, Save, Save as) – stores or retrieves the current PIVview parameter 
configuration in/from a file. This file is formatted in netCDF and therefore is platform 
independent but cannot be read be a standard text editor. 

 Recent images, Recent files – are listed by their names and are opened by clicking on 
them. Note that the PIV mode of operation does not automatically change for different image 
types. 

 New Window – starts are another instance of PIVview by opening additional main window. 
New windows operate completely independent of one another. 

 Exit terminates PIVview program. The current PIV, image and plotting parameters are stored 
in the Windows registry and are restored when the program is started again. 

Tip: Use parameter files if you plan to work with different types of images. 

 

The Image Menu 
 Image PreProcess – opens a dialog in which a variety of image pre-processing options can 

be set, such as splitting of the PCO-camera’s double image files, image filtering, histogram 
adjustment, background subtraction, etc. 

 Edit Mask – starts the mask editor PIVmask with the currently loaded image. Completed 
mask images can be loaded directly from  in the image pre-proceesing menu. 

 Calc. Minimum Image – allows the selection of an image sequence from which a minimum 
intensity image is computed. 

 Horizontal Profile, Vertical Profile – shows plots of image intensity profiles for the current 
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mouse cursor position. 

 
 

Zoom out, Zoom in – change the image magnification. The scroll bars on the edges can be 
used to pan through the enlarged image / data set (Shortcut keys are + and – ). 

 
 

Brighter, Darker – changes the visual brightness of the currently loaded image. The image 
data itself is not affected (The shortcut keys are b and d). 

 Auto-scale – sets default intensity on image 

 

 

Change LUT – changes the current image lookup table (LUT) or switches to previous LUT. 
Clicking on the function/button repeatedly cycles through all possible LUTs. Currently there is 
no provision for user defined LUTs. (Shortcut key is L). 

 Clipping – enables or disables image clipping for image intensties exceeding the LUT 
maximum intensity. With clipping on intensities greater than the maximum are set to the 
maximum. With clipped off the intensity wraps back to the bottom of the LUT  
(Shortcut key is c). 

 Show LUT – controls the display of the LUT bar on the left side of the image.  
(Shortcut key is CTRL+L). 

 Show Image – is useful to hide the image to better view the computed PIV data.  
(Shortcut key is I). 
 

The PIV menu 
 Calibration – puts PIVview into calibration mode, hiding the current PIV data set and 

displaying a moveable ruler and origin. Within a separate dialog the magnification factor and 
reference point coordinates can be defined interactivley. After closing this menu PivView 
reverts back to the interrogation mode. (Shortcut key is F3). 

 PIV ROI – puts PIVview into the ROI-mode in which a rectangular portion within the image 
can be defined for processing. To use this function the Use ROI option in the PIV Setup 
dialog has to be enabled (Shortcut key is F2). 

 Process Log – shows a window with processing messages. 

 PIV Configuration – opens a tabbed dialog in which a wide variety of PIV processing 
parameters can be defined (Shortcut key is F4 or via context menu by right-clicking the 
mouse). 

 Evaluate image – performs an evaluation of the loaded image (pair). For large data sets a 
progress bar is displayed during processing allowing the user to abort the interrogation. 
(Shortcut key is F5). 

 Batch Processing – opens a dialog through which ensemble PIV processing can be initiated. 

 Correlation Plane – displays the correlation plane  and associated PIV image samples (if 
chosen) in a separate window. The data in this window is updated each time a new 
interactive interrogation is performed on the image (by clicking the left button within the 
image, Shortcut key is F6). 

 2-D Histogram (PDF) – also is only available for evaluated PIV images. It plots the 
calculated displacement data in a two-dimensional plane and can be used in the vector 
validation procedure. Additionally one-dimensional histograms (PDFs) show the projection of 
the 2-D data onto each major axis. (Shortcut key is F7). 

 PIV Data Probe – is a window that is available after a PIV image has been evaluated. It 
gives detailed information about any calculated vector within the data set. The vector closest 



PIVview User Manual 9
 

to the mouse cursor is selected. 

 Statistics – provides information about the  currently displayed PIV data set, such as mean 
and RMS values of displacement, velocity, vorticity, etc. 

 Live Evaluation – if enabled PIVview will display newly computed vectors during processing 
of the image. 

 Clear PIV Data – deletes the currently displayed PIV data set. Usually any modification in the 
PIV Configuration menu has the same effect. 

 

The Plot menu 
 Plot Settings – opens a dialog in which the layout and properties of the plotted PIV data can 

be controlled. Among these are vector coding and length, scalar image display, axis and axis 
labeling, reference vectors, and color definitions (Shortcut key is P). 

 Subtract Mean – displays the vector field with or without the mean displacement of the data 
set subtracted. This is especially useful for displaying flow structures that might be hidden in 
a large, nearly uniform, convective flow. 

 Print Preview, Printer Setup, Print – handles printing within PIVview and includes 
previewing, layout and printer selection. (Shortcut key for printing is P). 

 Export as image> – stores the currently displayed data set or image in an image file 
(=screen capture).  Export formats include BMP, JPEG, PNG and others. Current zoom 
factors are used in the exported image. The larger the zoom factor, the larger the resulting 
image. 

  
 

Position objects – puts PIVview into and edit mode  where workspace objects (image, luts, 
reference vector,...) can be freely placed to suit the user’s preferences. 

 Save current LUT / Load LUT – save or load user specified pseudo-color lookup table 

 Default positions – restores the original positions of the workspace objects. 

 Save / Load plot configuration – stores/restores plot parameters 

The Window menu 
Hide Toolbars – hides all toolbars  

Individual toolbars can be activated or deactivated one by one. 

The Help menu 
PIVview options – displays the command line options available for PIVview. 

About PivView gives information about the program itself (e.g. release version number) as 
well as shows the currently registered end user. 
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The PIVview Toolbars 
 File>Open Image – is used to load a new image for PIV processing. 

 File>Open Data – is used to load a new data set for post-processing. 

 File>Save Data Set – opens a dialog with output options before saving the processed data 
set. 

 File>Create Tecplot Data – to save the processed data set in a format compatible with 
TecPlot. Style files for TecPlot are also generated. 

 Image>PreProcess – opens a menu with image pre-processing options (Short-cut key: 
CTRL+I). 

 Image>Edit Mask – starts the mask editor program PIVmask. 

 

 

Image>Zoom out, Image>Zoom in – increases or reduces the magnification of the image 
on the screen. If the image no longer fits the screen scroll bars on the edges allow image 
panning (Short-cut keys: +,–). 

 Image>Brighter – increases the image brightness on the screen (Short-cut key: B). 

 Image>Darker – decreases the image brightness on the screen (Short-cut key: D). 

 Image>Auto-scale – sets default intensity on image 

 

 

Image>Change LUT – changes the display look-up table (LUT). Each click of the icon 
picks the next or previous LUT in a circular list. When scalar data (e.g. vorticity) is 
displayed in place of the PIV image, the accompanying LUT is changed. (Short-cut key: L). 

 PIV>Calibration – opens a menu for online length calibration . Only the image with an 
overlaid ruler and origin are displayed (Short-cut key: F3). 

 PIV>PIV ROI – changes into selection mode region of interest (ROI), (Short-cut key: F2). 

 PIV>PIV Configuration – opens a tabbed menu with PIV processing parameters (Short-
cut key: F4). 

 PIV>Evaluate Image – performs evaluation of PIV image using current configuration 
defined by the PIV processing parameters (Short-cut key: F5). 

 PIV>Batch Processing – opens the batch processing menu. 

 PIV>Correlation Plane – displays the correlation plane during interactive interrogation 
using the mouse. 

 PIV>2-D Histogram – displays a global histogram of the currently computed data set. 

 PIV>Data Probe – shows a window with detailed information about any calculated vector 
within the data set. The vector closest to the mouse cursor is selected. 

 PIV>Statistics – presents a summary of statistics of the computed data set including the 
number of data points, number of outliers, various mean values and standard deviations as 
well as the maxima and minima. 

 Plot>Plot Config. – opens a tabbed menu with vector and contour plotting parameters 
(Short-cut key: p). 

 Plot>Subtract Mean – subtracts the mean displacement from the data set before plotting 
it. 

 Plot>Print – sends the currently displayed data set to the printer. 
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Plot>Position Objects – allows free position of workspace objects such as lookup-tables, 
image or reference vector. 

The PIVview Dialogs 
The Image Pre-Processing Menu 
The purpose of this menu is to perform a variety of operations on the PIV image(s) prior to 
the PIV analysis. This includes basic image re-orientation, image enhancement using filters, 
background subtraction or mask overlays. Each of these are described in more detail below. 

  

Tab General  
Always Split PCO Images – PIV image pairs recorded with the PCO acquisition software 
are generally stored in a common file. The upper half of the image is associated with the first 
exposure while the lower half corresponds to the second exposure. This operation splits the 
input file into the two images. Otherwise the software will try to find the matching second 
image. 

Rotation – rotates the image(s) in 90° increments. This operation as well as all others is 
performed on both images of a pair. 

Mirror – can flip the image either left-to-right or top-to-bottom. Both flip operations together 
are equivalent to a 180° rotation. 

Tab Filters  
Filters are applied in the order they appear in the menu. 

Convert Images to Floating Point Data – prevents truncation of data during filtering 
procedures (may increase overall precision). 

Invert – computes the negative of the image by turning bright pixels into dark ones and vice-
versa. 

Median Filter – performs median filtering on the data using a 3x3 or 5x5 kernel. 

Dynamic Thresholding – performs percentage-based thresholding of the image. This 
operation determines the minimum or maximum cut-off thresholds by summing up the 
individual bin-counts of the image histogram. The threshold is value is determined when the 
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percentage of pixels in the sum exceeds the percentage specified by the user. (Obviously 
this only works for images which a not binary.) 

High Pass Filter – performs a high-pass filtering of the image by subtracting a lowpass-
filtered version of the input image. Both the kernel size and filter-shape (Rectangle or 
Gaussian) of the low-pass filter can be specified. Gaussian filtering somewhat slower but 
positively influences the final result. Negative values are clipped only if this option is 
activated. 

Binarization – binarizes the the image data by setting pixel values above the specified 
threshold to white (255) and lower values to black (0). 

AntiAlias (Smoothing) – applies a low-pass filter which can be used to damp out spurious 
noise in the image.  
Tip: The combination of the last three filters can significantly help in processing images with low signal 
to noise ratio.  

  

Tab Background  
Subtract Background When activated the specified image or image pair is subtracted from 
all data images upon loading. Background subtraction can improve the data yield in images 
suffering from strong background artifacts. The image size of this background has to match 
that of the PIV image. Separate background images for each image of a pair may be 
specified. 

Tab Mask  
Use Mask When specified mask images are used to blot out data in regions covered by the 
mask. Separate mask images for each image of a pair may be specified. 

Invert Mask Inverts the pixels of the mask images prior to application. 

Randomize masked pixels This is an empirical method to reduce the influence of the 
masked areas on the correlation signal. Normally masked pixels are set to zero prior to 
correlation. This may result in edge artifacts in the correlation plane. In this case the masked 
area is filled with random data that should have roughly the spectral characteristics of the 
unmasked data and generally reduces the edge artifacts in the correlation plane. 
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PIV Evaluation Setup 

PIV Evaluation Setup – Grid  
This dialog can only be opened when an image (pair) is loaded. The image is then overlaid 
with a grid of crosses indicating the centers of the correlation samples (i.e. interrogation 
windows). 

 
Window Size 
The menu entry defines the interrogation window size, that is, the rectangular size with which 
the PIV images are sampled to perform the local cross-correlation analysis. Frequently the 
interrogation window is also referred to as interrogation spot. The window dimensions can be 
freely set (e.g. 24x27 is also possible). 

Step Size 
defines the increment with which the images are sampled. These values define the mesh 
size of the final data size. Typical values are around 50% of the window size which satisifies 
the sampling criterion. Greater sample overlap (e.g. smaller step sizes) produces over-
sampled data but does not necessarily yield additional information. 
Image Offset 
Applies a constant integer offset to the interrogation windows by offsetting the images with 
respect to each other. This offset is applied to the displayed image (with the exception of 
double-exposure autocorrelation images). Interrogation window offset is especially useful in 
the analysis of images with large convective displacement (e.g. pipe flow, wind tunnel flow, 
etc.). 

Grid alignment 
Allow the grid to be aligned either with the bottom or top edge of the image. Alternatively the 
grid may be locked to any specified point (pixel) the image. 

Use ROI 
Restricts the evaluation to a defined rectangular region within the image. This region of 
interest (ROI) can either be set by entering boundary positions or interactively by using the 
ROI button on the toolbar or menu entry PIV>Select ROI. 

 Process Button – closes this menu and starts evaluating the image. 
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 Default Button – resets all values in this menu to their default values.  

 

PIV Evaluation Setup – Correlation 

 

Phase-correlation (Phase only correlation) 
This approach spectrally filters the data such that only the phase information is used in the 
calculation. The technique, proposed by Wernet (2005), has the potential of obtaining a 
higher correlation signal. 

Nyquist Frequency Filtering 

This option removes the highest frequency components in the cross-power spectrum (Fourier 
transform of the correlation function). This can be of use in the removal of camera noise 
artifacts (interlacing, multi-channel readout, etc.). The correlation plane window should be 
used in diagnosing the function’s performance. 

Multiple Correlation 
This algorithm essentially calculates the correlation from at least two slightly spatially 
separated correlation planes. An approach based on multiplication of correlation planes was 
first proposed by Hart (2000). By calculating the product or sum of these correlation planes a 
new correlation plane results which ideally contains only the single displacement peak. Due 
to the random position of the noise peaks, which are present in all standard correlation 
planes, the final correlation plane will show no or strongly reduced noise peaks. Hence, this 
procedure effectively increases the detectability of the correlation peak associated with the 
particle shift. 

The algorithm requires additional processing time depending on the number of additional 
correlations calculated and does not perform equally well on all images. A careful adjustment 
of the offset between the sample positions is sometimes necessary. If correlation planes are 
too far displaced from each other the correlation signal may be lost entirely in high gradient 
flows. The correlation plane window should be used in diagnosing the function’s 
performance. 

When the number of repeated correlations is higher (more than 3) then the averaging mode 
should be preferred to the multiplication, because this approach is less susceptible to loss of 
correlation in one of the repeated correlations. 
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PIV Evaluation Setup – Algorithm 
Advanced Correlation Techniques  
If none of the advanced algorithms are activated PVview uses the classical cross-correlation 
method as described in various PIV references (e.g. Willert & Gharib, 1991). More advanced 
algorithms are briefly described in the following. 

 
 

Interrogation method 
Allows the selection of different PIV interrogation schemes: 

Standard, single pass interrogation does classical PV interrogation without additional 
passes to improve the result 

Multiple-pass  interrogation The interrogation of the image is repeated at least once more. 
In the following passes the image sample positions are offset by the integer shift 
determined in the preceding pass. Once the residual shifts are less than one pixel a 
re-evaluation of the respective point is no longer necessary (e.g. convergence). The 
maximum number of interrogation passes can be specified. Two to three passes are 
generally sufficient for convergence. 

Multiple pass interrogation not only increases the data yield due to the higher amount of 
matched particle images, but also reduces the so called bias-error (Westerweel et al. 
1997). Outlier detection is used to validate intermediate data sets. 

Multigrid interrogation uses a pyramid approach by starting off with larger interrogation 
windows on a coarse grid and refining the windows and grid with each pass. Outlier 
detection is used to filter the intermediate results. 

Multiple-pass options 
Number of iterations – specifies the number of passes during multiple-pass PIV 
interrogation. 

Multi-grid options 
Initial sampling window – specifies the starting interrogation window for multi-grid PIV 
interrogation. The final window size is set in the Grid menu tab. 
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Image interpolation options 
Sub-pixel image shifting – enables sub-pixel based image shifting (image deformation) on 
multiple-pass- or multi-grid interrogation. This technique is a second order method and 
involves a complete deformation of the image data using the displacement data of the 
previous interrogation passes. 

Interploation scheme – provides a choice of different pixel interpolation schemes as well as 
the order. In general cubic B-splines were found to produce the best results. 

Speed optimization options 
To increase processing speed intermediate processing step may use faster peak fitting 
algorithms or simpler image interpolation schemes. This may have a minor influence on the 
final result (e.g. reduced precision and/or reduced vector detection rate). 
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Flowchart for coarse-to-fine multi-grid processing with image deformation for second order 
accurate PIV interrogation. 
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Advanced PIV Processing options 
Store intermediate deformed images – is active during image deformation schemes. If 
checked the program stores the iteratively deformed images for each intermediate 
processing step (after image deformation). 

Sample-overlap for multi-grid processing – determines the sampling grid for the 
intermediate steps of mutli-grid schemes. 

Multi-grid – Final scan – determines the number of repeated interrogations at the final grid 
resolution. Generally one final scan is sufficient whereas additional scans may increase the 
precision. 

Limit peak search area – is active only for the final passes of multi-grid algorithm at the final 
grid resolution. In general the iterative schemes should converge on the underlying data 
within a few pixels (or less) such that the correlation peak search area can be restricted. 
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PIV Evaluation Setup – Peak Detection 

 

Sub-Pixel Peak Fit 
Various peak fit algorithms are available which recover the sub-pixel displacement of the 
correlation peak: 

3-Point Gauss Fit This is the most frequently used scheme as proposed by Willert & Gharib 
(1991). It selects the four closest neighbors of a correlation maximum and fits a 3-
point Gaussian curve along each of the two major axis. 

Least Squares Gauss Fit Similar to the 3-point Gauss fit but uses all 8 points surrounding 
the maximum. Since it uses more data for the location of the peak the noise in the 
result is generally less than with more simple fits. This peak fit method is 
recommended for most applications. 

3-Point Parabolic Fit Similar to the 3-point Gauss fit except that it is only fits a parabola 
through the three points. 

Center-of-Mass Fit This sub-pixel locator uses a specified number of correlation values 
surrounding the maximum (3x3, 5x5, etc.) and calculates the associated first moment 
or center of mass. It is generally not well suited for the narrow correlation peaks 
recovered from typical PIV images. In cases where larger particle images or larger 
features have to be correlated, the correlation peak will be wider and this  fitting 
algorithm may yield more accurate data. 

Whittaker Reconstruction Recnstructs the correlation function from all correlation values 
along the horizontal and vertical line crossing the brightest correlation value (peak) 
and estimates the maximum from this function. 

Nonlinear Gaussian Peak Fit Uses up to N2 points for a parametric fit to a Gaussian-
shaped function allowing for peak ellipticity. The peak shape is estimated from the 
autocorrelation function of the image samples which may reduce overall processing 
speed. 

Limited Peak Search Area 
When activated the correlation peak detection is restricted to an area whose size can be 
selected. For data with a small dynamic range a limited search area can significantly 
increase the data yield. That is, only the area enclosed by the given rectangle is scanned for 
the correlation peaks. 

Disable Self-Correlation Peak 
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disables the use of the correlation peak near the origin which may be useful in images with 
strong (stationary) background artifacts which may hide the actual signal. Correlation peaks 
falling within the specified radius from the origin are disabled. 
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PIV Evaluation Setup - Outliers 

Outlier Detection Methods  
The definition of outliers in experimental data can be very subjective. In general an outlier in 
PIV data can be considered to be a spurious vector within an otherwise homogenous 
displacement field (see Sec.6.1, Data Validation, in Raffel et al., 1998 for more information). 

When activated several methods for outlier detection are available. By combining the various 
methods most outliers are detected with very little valid data disabled (known also as 
optimization of cost). 

 
Maximum Displacement – Any displacement vector exceeding the specified magnitude is 

considered to be an outlier. 
Maximum Displacement Difference – This method computes the magnitude of the vector 

difference between the vector in question and its eight surrounding neighbors. When 
this difference exceeds the specified value for more than 4 neighbors, then the 
analysed vector is labelled to be an outlier.  

Normalized Median Filter – applies a median filter to each vector along with its eight 
neighbors. A vector is an outlier if the difference to the median displacement value is 
greater than the given threshold. 

Dynamic Mean Filter – This filter works very effectively even in flows with discontinuities 
(e.g. shocks). However it requires a careful adjust of the coefficients to work reliably 
(see Raffel et al., 1998, p.153 for more information). 

Minimum signal-to-noise ratio – disables all displacement vectors which have a SNR less 
than the specified value. 

Ratio Peak 1 to Peak 2 – disables all displacement vectors for which the ratio between the 
strongest and second strongest correlation peak is less than the specified value. 

Minimum correlation – disables all displacement vectors for which the correlation peak 
value is less than the specified value. 

Global Histogram – restricts valid vectors to be within a certain range of displacements. 
This rectangular or elliptical domain has to be set interactively within the PDF-window 
using the mouse. 

 



PIVview User Manual 21
 

Outlier Replacement Schemes 
Once outliers have been detected they can be optionally replaced with new data. Two 
replacement schemes are available:  

Other Correlation Peaks – The program stores the three highest correlation peaks found in 
each correlation calculation. If the highest correlation peak turns out to be an outlier this 
options picks the next highest correlation peak and repeats the outlier detection procedure. 

Interpolation – Applies a bi-linear interpolation to estimate the replacement vector. When 
several of the immediate neighbors are also outliers then a Gaussian-weighted interpolation 
scheme is used. 

Re-evaluate with larger sample – If none of the alternative correlation peaks fulfill the 
validation criteria, the image can be locally re-evaluated with the next largest interrogation 
sample in the multi-grid processing scheme. 

Note: All correlation peaks are first tried out before any data is interpolated.  

 

The Apply Button can be used to immediately see the effect of the outlier detection and 
replacement provided that the image is already evaluated. 
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PIV Evaluation Setup - Conversion 
This dialog is used for setting the magnitude and time conversion factors which are 
necessary to obtain velocity data in a physical grid. Within PIVview the horizontal display axis 
is always associated with the X-axis, the vertical with the Y-axis. No Z-coordinate is used. If 
the measured PIV plane is not aligned with the desired physical space coordinates, the user 
has to perform the required transformation on the PIVview output using other software. 

When this menu is activated, a ruler and current origin are displayed within the image. The 
ruler may be used to mark off know lengths in the image. The magnification factor can be 
interactively set by supplying the associated physical length in the menu. 

Movement of the origin changes the entries in the menu accordingly. 

 
Pulse Delay – specifies the time delay between the two exposures in the image pair. 
Generally does not apply to speckle displacment data.  

Magnification Factor – The scale factor used to conversion the image displacement to a 
physical displacement. It can also be set interactively using the calibration menu.  

Length Unit – The units used for the physical coordinate system. It is also associated with 
the magnification factor.  

Displacement Unit – The unit associated with speckle displacement data. Also the physical 
particle image displacement prior to its conversion into velocity.  

Velocity Unit – The unit associated with the velocity as estimated by PIV.  

Origin  
The origin is used as the reference point for the physical coordinate system of the data set. It 
can be translated within the image by holding down the left mouse button.  

Origin Offset – Additional offset in physical space units if reference point is not at (0,0,0) in 
physical space.  

Magnification Factor – This field is used for the calculation of the magnification factor by 
using the pixel length of the ruler within the image (numerator) and the actual distance in 
physical units (denominator). Only the physical distance can be modified here. The ruler 
length can only be changed by altering the ruler end points in the image. 

The Apply Button can be used to immediately see the effect of the conversion factors on 
the data and grid. 
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PIV Evaluation Setup – Filters etc. 
The menu tab allows the selection of various post-processing options. 

 
Median Filtering  
The final data set is once median filtered using either a 3x3 or 5x5 kernel. 

Data Smoothing  
The final data set is once smoothed using a Gaussian weighted kernel of specified width. 

Differentiation 
Calculate cell size for differentiation The estimation of differential quantities (e.g vorticity, 
shear strain, etc.) relies on calculating differences between neighboring vectors and can 
therefore be very noisy especially if the seeding density is low and the data points are closely 
spaced. Generally it was found that differentials calculated from PIV data sampled at less 
than 50% overlap are increasingly noisy due to artifacts introduced as a consequence of 
nearly identical particle image pairs in neighboring sampling positions.  

In other words, for correlation planes calculated from two nearly overlapping sampling areas 
most of the particle image pairs can be found in both samples. Especially in areas of high 
gradients the data will be biased according to the mean displacement of all pairs. Closely 
sampled data will then show a similar bias in neighboring points and thereby provide an 
underestimated differential. 

When activated, this option checks the sampling (interrogation) window overlap and from it 
determines an optimal distance from which to calculate the differentials. 

Alternatively, the user can specify the spacing for the calculation of the differentials. 

Extrapolate to edges – Generally differentials cannot be estimated at the borders of the 
data set. However, by extrapolating the vectors beyond the edge using the interior vectors 
the differential at the edges can be estimated. 
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Region of Interest  
 This display mode can only be activated if the ROI-option is checked in the Grid Tab of 

the PIV-parameter menu.  

The region of interest (ROI) is used limit the evaluation grid to a defined rectangular region. 
This region is shown as a red/white border whose corners and mid points can be translated 
by holding down the left mouse button.  

Yellow +‘s inside the ROI indicate the centers of sampling positions for the correlation 
analysis. Their spacing is defined in the Grid tab of the PIV configuration menu. 

 

 
Image overlaid with ROI-selection rectangle. Yellow crosses mark the centers of the 
interrogation windows. 
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Plot Configuration Menu 

 
 

Vector Plotting Parameters  
Show Vector Field – has to be enabled to show the vectors. If a data set is available, that is, 
the image is evaluated, then enabling this option will immediately display the vector field. 

Vector Size / Spacing 
Both the vector head length and width can be specified here. Also there is the choice to fill in 
the arrow heads.  

Vector Stretch Factor – Specifies the amount the displacement is scaled with respect to the 
image. For example, a vector with length 10 pixels with a scale factor of 2.0 is 20 pixels long 
when plotted on the image. The stretch factor is always based on the pixel displacement of 
the data.  

Maximum Vector – Can be used to avoid plotting vector whose length exceeds the value 
specified (e.g. outliers). The magnitude is specified in pixels.  

Spacing – This option allows vectors to be skipped and is useful when the data is too dense 
to be properly displayed.  

Outlier display  
Determines how outliers should be treated on the screen: 

Mark outliers with X – when activated any vector labeled as an outlier will only be indicated 
by an x.  

Hide Outliers – when activated any vector labeled as an outlier will not be shown.  

Show Outlier Vectors – when activated any vector labeled as an outlier will be shown.  

Offset Vector 
Subtract Image Offset – When activated the image offset specified in the evaluation setup 
menu will be subtracted from each displacement vector.  

Subtract Mean Displacement – When activated the mean displacement of all vectors in the 
field will be subtracted. If disabled a user specified offset can be subtracted (see below).  
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Specified Offset Vector – The user can specify a given displacement to be subtracted from 
the vectors. This value is given in pixel displacement but is also displayed in physical units 
for reference. This field only become active if the Subtract Mean option (above) is disabled.  

Color Coding  
Magnitude – color-codes the vectors according to their magnitude. Generally a rainbow-type 
of LUT is used (several are available). The minimum and maximum magnitudes for the color 
bar can be specified in the fields below. 

Signal-to-noise Ratio – color-codes the vectors according to their signal-to-noise ratio in the 
displacement estimation. 

Validation – color-codes the vectors according their status of validation. The color coding 
can be set in the Fonts/Colors tab of the menu. 

Uniform Color – alternatively the vector can be plotted in a desired uniform color; that is 
without color-coding. The color may be chosen through a color selection menu. 

 

Apply Button – any change to the setup can be immediately displayed by pressing this 
button. 

Vector Style 
This sub-menu provides further choices on the vector shape, size 
and positioning. 
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Contour Plotting Parameters  
Within PIVview a contour image describes a color-coded representation of a scalar quantity 
derived from the PIV data. These include velocity magnitude, vorticitiy, strain or single 
components of velocity.  

Show Contour Image – has to be enabled to show the contour image. If a data set is 
available (i.e. image is evaluated) then enabling this option will immediate display the contour 
plot. Bi-linear interpolation is used to fill in the area between the individual data points.  

 

Contour Type  
Specifies which kind of data is plotted as a contour plot. The contour display range can be 
adjusted below.  

Vorticity  
plots the out-of-plane vorticity ωz as estimated by finite differences: 
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Shear Strain 
plots the in-plane shear strain εxy as estimated by finite differences: 
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Normal Strain  
plots the sum of the in-plane extensional strains η as estimated by finite differences: 
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Displacement Magnitude  
plots the pixel displacement vector magnitude. 

Velocity Magnitude  
plots the velocity vector magnitude. 

Physical Displacement Magnitude  
plots the actual physical displacement of the particle images or speckle patterns. 
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Correlation Coefficient  
color-codes the image according to the correlation coefficient from the displacement 
estimation. 

Enstrophy  
color-codes the squared magnitude of the out-of-plane vorticity ωz. 

Lambda operator 
color-coding according to: 
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Vector Count  
color-codes the number of validated data in averaged PIV data sets (only for averaged 
data). 

3-C vector residuals 
color-codes the residuals from a 3-C vector reconstruction for stereo PIV (only available 
for stereo PIV data).  

 (other options may also be available) 

Contour Display Range  
Specifies the range of contour values to be shown. These values are also displayed on the 
lookup-table above the contour plot.  

Nice Range  
calculates nice (or round) limits for the color bar using the maxima available from the 
current data set.  

Show Color Bar  
This option determines whether the reference lookup table is shown. This color bar is 
placed above the data field. 

Discrete Contours  
when enabled discrete contour levels are shown. Otherwise a smooth transition from 
minimum to maximum is used.  

Reverse LUT  
when enabled reverses LUT 

Wrap LUT  
starts from the lower end of the look-up table for values exceeding the specified range. 

Fill Background  
fills the image background with the zero-contour color. 
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Axis Plotting Parameters  
This dialog controls the type of axis and axis labeling on the displayed data. Either image or 
physical coordinates may be used. The appearance of each axis may be controlled 
independently. 

 
 
Show Axes – has to be enabled to place axes on the edge of the image or plot.  

Image coordinates – plots the data in image space [pixels].  

Physical coordinates – plots the data in physical (object) space using the currently active 
scaling factors.  

Show Labels – has to be enabled to place labels on either of the axes.  

Tic Spacing – defines the increment of the tics to be labeled (major ticks).  

Tic Anchor – sets a (virtual) starting point for the major ticks to ensure a nice layout with 
even label numbers. 

Skip – defines which of the major ticks should not be labeled (0 for to label all major ticks, 1 
to label every other, etc.). 

Minor Ticks – sets the number of minor ticks between two major ticks.  

Show Title – has to be enabled to place a title on either of the axes. The title is defined in 
the entry field below. 
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 Reference Vector 

 
Show Reference Vector – has to show a reference vector in the upper left corner. It is only 
displayed in the presence of a vector map or during interactive interrogation. 

Type of Ref. Vector – three different forms of labeling the reference vector are possible: 

Displacement – chooses a image based reference scale in pixels; 

Velocity – labels the vector with the currently active velocity unit; 

Phys. Shift – uses the physical shift of particle images. 

 

Fonts / Colors 

 
Font – allows the selection of the font type and size used for axis and LUT labels. 

Color Preferences / Vector color coding – defines the color for various plot items and data 
types (e.g. outliers vectors). 
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The Preferences Menu 

  
Recent Image List – determines how many image files should be listed in the File>Recent 

Images menu option. 

Recent File List – determines how many PIV data files should be listed in the File>Recent 
Files menu option. 

Show Splash Screen – if enabled, shows the startup splash screen. 

File Extensions  
This menu associates a variety of image types with certain file extensions. These extensions 
are then used as file filters in various image selection dialogs. The drop-down selection offer 
the following image types:  

PIV Images Pairs – are used for cross-correlation PIV and defines the first image of a pair of 
single exposed PIV images.  

Double Exposed PIV Images – are used for the selection of images for autocorrelation PIV.  

Speckle Reference Images – defines the zero-state (e.g. un-deformed) image used in 
speckle shift measurements.  

Speckle Signal Images – associates images where the speckles have been displaced with 
respect to the zero-state image.  

Mask Images – are images that are overlaid and disable any data covered by them. 
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Correlation Plane Window 
The correlation plane data is color-coded using the currently active lookup table - in the 
example above, a gray-scale LUT. Bright pixels indicate a high correlation value, dark ones a 
low correlation. The local correlation values are displayed in the status line by moving the 
mouse across the image. 

Red lines – at the center of the 
correlation plane marks the origin, that 
is, the position of zero displacement. 

Green Rectangle – near the center of 
the correlation plane indicates the 
region of interest for the peak 
detection algorithm. It is only visible if 
the ROI peak search is enabled in the 
processing setup. 

Image Samples – to the right of the 
correlation plane the two image 
samples from which the correlation 
was calculated are displayed if the 
toolbar button  is enabled.  

Note: In case of double-correlation, 
the two images represent the two 
correlation planes from which the 
plane shown on the left was 
calculated. 

 

 
 

Change Image Magnification – these buttons increase or decrease the magnification of the 
displayed image data.  

 Change LUT – alters the lookup table (LUT) used to display the correlation / image data. 
Each time the button is pressed a new LUT is applied. 

 Display of Image Samples – this button must be enabled to display the image samples in 
addition to the correlation plane. 

 Saving the Correlation Data – the currently displayed correlation data and image samples 
can be stored in ASCII files by pressing this button. Once the data is saved the button is 
deactivated until new correlation data becomes available. 

 Printing – of the correlation plane using printer selected in Plot/Print Setup menu option. 
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Global Histogram Window 
This plot gives a visual representation of all displacement values available for the evaluated 
image. Each colored point in the two-dimensional plane represents a displacement vector 
whose coordinates correspond to the actual shift in pixels. The boundary of this plot is 
defined by the size of the correlation plane with zero shift at the center.  

The rectangular and elliptical regions near the center are user-sizeable regions of interest. 
These ROIs can be used as a form of data validation: any points on their exterior are 
considered to be outliers. To use this function, the Global Histogram option must be enabled 
in the validation menu. 

 

Global histogram of PIV data with two ROIs 
enabled, one rectangular (currently 
selected) and one elliptical. The one 
dimensional PDFs are shown for the X-axis 
below and for the Y-axis on the right. 

Detail of the figure to the left. Points 
outside of the ROIs are labeled as outliers 
as indicated by their red color. 

 

 One-Dimensional Histograms – immediately bordering the 2-D histogram are vertical (right) 
and horizontal (below) one-dimensional histogram of the two respective displacement 
components. They are projections of the two-dimensional histogram onto either of the major 
axes. Their range therefore corresponds to the respective dimension of the correlation plane. 

Sub-Pixel Histograms – these histograms, located the furthest from the 2-D histogram, are 
generated by plotting only the non-integral part of the displacement values. Their range is 
from -0.5 to 0.5 with a default bin-width of 1/20th a pixel.  

Sub-pixel histograms are especially useful to check whether peak-locking effects are present 
in the data. 

 
 

Zoom in / Zoom out – these buttons increase or decrease the magnification of the displayed 
histogram data.  

 This button enables the global histogram validation. Alternatively the Outlier Configuration 
menu can be used. 

 toggles the currently selected ROI between elliptical and rectangular shape.  
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 Validation with new ROI – if global histogram validation is enabled, then a change to the ROI 
can be tested directly on the data with this button. 

 Default ROI – this function resets the currently selected ROI such that it nearly covers the 
entire histogram plane. This is especially useful if the ROI is lost off the histogram plane. 

 
 

Adds or removes ROIs from the histogram plane. Up to hree ROIs can be activated. 

 

 

 

1-D PDFs and Peak Locking 
The histograms (PDFs) below illustrate the effect of peak-locking which is a tendency of the 
peak-fitting algorithm to lock into integer values. The histogram on the top shows the 
presence of peak-locking in the form of integer-spaced peaks. The corresponding sub-pixel 
histogram below shows a triangular shape with increased counts near integer values (middle 
of histogram). 

The histograms on the below were obtained from the same image but processed with a 
different peak fitting algorithm (least-squares fit). No peak-locking can be observed - the sub-
pixel histogram has a near uniform distribution. 

Peak-locking generally arises through a combination of certain particle image sizes (typically 
too small) whose narrow peaks in the correlation plane are analysed with the wrong type of 
peak fitting algorithm. Another cause may be the non-uniform spatial pixel response of the 
recording device (CCD) in combination with particle images with diameters less than 3 pixels. 

  
One-dimensional PDFs of PIV data 
containing peak-locking effects. 

Same PIV-data as on the left but 
processed with a different peak-fitting 
algorithm – no peak locking is noticable. 
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Batch PIV Processing 
 Batch processing is a means by which large number of PIV recordings can be evaluated 

in an efficient manner. A common set of analysis parameters is used for all images. During 
the processing the program accumulates the mean and RMS displacement and velocity data 
which are stored in a separate file after completion of the processing sequence. 

 
 

Available Files – the left column shows the files currently available in the specified directory. 
Multiple files can be selected by holding down the CTRL or SHIFT keys (just as in the 
Windows Explorer) Using the Add button the file selection is transferred to the list of files to 
be processed.  

Selected Files – The right column shows the files currently chosen for batch processing. In 
analogy to the left column multiple files can be selected by holding down the CTRL or SHIFT 
keys. Using the Remove button the file selection is removed from the list. 

Directory – this field displays the currently selected data (image) directory. It can be 
changed using the Directory button on the left.  

File Type – this field acts as a file filter showing only file which match the chosen extensions 
(File type association is defined through File>Preferences>File Type.) 

Filter #1 - Selects files in data directory with this (prefixed) filter. Allows selection of all odd or 
all even numbered files. 

Filter #2 - A file filter that may be freely modified. Caution: Without the asterisc (*) no files 
may be displayed. 



36 PIVview User Manual
 

 

Batch Processing Options 

 
Perform ensemble correlation – Rather than calculating the displacement field for each 
image pair, this method computes the averaged correlation planes from all images before 
detecting any correlation peaks. This procedure is common in the analysis of µPIV 
applications and reduce the effects of underlying Brownian motion. 

Load processing parameters from file – When enabled, the images will be processed 
using the parameters in the specified file. Otherwise the evaluation uses the currently defined 
parameters. 

 

Batch Processing Output Options 
A variety of output options may be defined in this menu. Preferably the data from each 
processing image should be stored in the platform independent netCDF format. This data 
can then be exported in any desired form using the same batch-processing menu. 
 

 
Stub for Statistics Files – specifies the beginning letters of the statistics files generated 
during batch processing. These data sets are computed over all available files and are stored 
after the batch processing is completed.  

For the stub seq the output files will be: 

seqAvgPiv.dat   mean pixel displacement  

seqAvgVel.dat   mean velocity  

seqRmsPiv.dat   RMS pixel displacement  

seqRmsVel.dat   RMS velocity  
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Store data for each processed image/file – When enabled, this option will store the 
displacement and velocity data for each processed image or file. Otherwise only the mean 
and RMS data sets computed from all images will be stored.  

Generate plot for each processed image/file – when enabled, this option will generate an 
image file (plot) for each processed image using the currently defined plot configuration. This 
is useful if animated sequences of the data are to be compiled later on. (Note: These files are 
quite large and may result in the use of much disk space.) 

Put image / data into separate directory – this option can be enabled to store the 
computed data in a directory different from the image directory. This can be useful when 
batch-processing images retrieved from a read-only medium (e.g. CD-ROM). 

Definition of statistics terms 
Statistical quantities such as the mean and standard deviation of velocity are calculated by 
the following equations: 
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Values for v’v’, w’w’ and v’w’ are calculated 
correspondingly. 
Only validated and interpolated vectors are 
used in the calculations.  
A multiplication with density ρ results in the 
respective Reynolds stresses. 
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PIVmask - Image Mask Editor 
The program PIVmask allows the creation of image masks that can be overlaid on PIV 
images to prevent processing in these areas.  Any PIV image can be opened using the 
File/Open function.  Several simple shapes then are available for the creation of the mask. 

Once finished the mask can be stored as a bitmap file. To enable its use by PIVview the 
appropriate option in the image preprocessing menu must be activated. 

 
PIVmask in edit mode displaying several shapes during the creation of a polygon. 

File Menu 
 File / Load image - loads one of the supported PIV image types. 

 File / New - resets the image mask by removing all objects. 

 File / Save mask image - saves the currently displayed mask as a bitmap file (BMP). 

View Menu 
 
 

View / Zoom in, Zoom out - changes the magnification factor of the image on the screen. 

 
 

View / Darken image, Brighten image - changes the brightness of the displayed image. 

 View / Change LUT - changes the image display lookup table 

 View / Toggle pixmap size - displays larger tool buttons. 
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Draw Menu 
 Draw / Toggle current mask - either calculates and displays the current mask by 

overlaying on the image or switches back to edit mode. 

 

 Draw / Invert mask - calculates the negative of the current mask. 

 Draw / Move/resize objects - allows selection of objects and as well as their size 
modification. 

 Draw / Move object vertices - allows the shape of polygon objects to be changed 

 Draw / Draw rectangles - creates a rectangle on the screen by dragging the mouse. Its 
shape can be later modified using the resize objects entry. Pressing the shift key allows the 
creation of squares. 

 Draw / Draw ellipses - creates ellipses. Circles are generated by pressing the shift key. 

 Draw / Draw centered ellipses - creates ellipse starting from their center point. Circles are 
generated using the shift key. 

 Draw / Draw Polygons - allows the creation of irregular polygon shapes. Points are added 
to the polygon with the left mouse button. The right button closes the current polygon. 

 Draw / Delete object - deletes the currently selected object. 

 

PIVmask in mask display mode. Objects 
extending beyond the image dimensions 
have no influence on the mask. 

PIVmask in mask display mode showing 
an inverted mask. 
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Stereo PIV Modules 
Stereo PIV processing is possible through a separate set of modules for PIVview. These 
modules are tied into PIVview3C but can be also be used in stand-alone fashion.   
Stereoscopic PIV is considerably more complex than standard 2-C PIV implementations. The 
use of the stereo modules is not quite as straight forward and requires that the user has a 
basic understanding of stereo PIV implementations - namely the concept of image 
registration through back-projection. Aside from reading this brief introduction new users are 
encouraged to study the stereo PIV example(s) supplied on the program CD. 

Stereo PIV Procedure in PIVview3C 
The figure at left illustrates the general 
procedure followed by PIVview for stereo 
PIV processing. The following 
files/information are required: 

 a set of simultaneous acquired PIV 
images for both camera views (e.g. 1 PIV 
image pair per camera) 

 images of a calibration grid placed 
parallel to the light sheet - one image per 
camera. The grid should also have some 
clearly identifiable reference marks on it 
to identify its orientation. 

 the position of the cameras in physical 
space with respect to reference grid 
(more on this later). 

MapImage MapImage

Camera A Camera B

DPIV DPIV

Stereo

StereoGeom

Image back-projection
using mapping data
from PIVmap (T01)

Image back-projection
using mapping data
from PIVmap (T01)

Standard 2-C PIV
Processing

Standard 2-C PIV
Processing

merges PIV data
sets from each
camera view

specifies the stereo
viewing geometry

IN ININ IN

IN IN

IN IN

OUT OUT

OUT OUT

OUT

Dewarping
coefficients

for
Camera A

Dewarping
coefficients

for
Camera B

IMA IMA

IMA IMA

IMB IMB

IMB IMB

PIV Image Pair PIV Image Pair

Dewarped Image Pair Dewarped Image Pair

2-C PIV
Data File

2-C PIV
Data File

3-C PIV Data File

(netCDF) (netCDF)

(netCDF or
Tecplot-Format)  

 
The first step involves determining two sets of coefficients which allow the PIV recordings to 
be matched to each other. This projection of the images into a common image plane shall be 
referred to as image back-projection. The grid images are essential for determining the 
projection coefficients as the spacing between the grid lines is well defined. The modules 
PIVmap3 and PIVmapT01 (formerly named T01) use semi-automated line or dot grid 
detection algorithm for exactly this purpose.   

Once the projection coefficients are known, PIV images for each view can be back-projected. 
The command-line program mapimage can also be used for this purpose. Note that PIVview 
does not allow you to load images as long as the mapping coefficients are unity (e.g. not 
calculated). 

The back-projected PIV images can now be processed by standard (2-C) PIV interrogation. 
In PIVview3C the same interrogation parameters are used for both views to ensure that the 
resulting data sets exactly match in size and position. Command-line based PIV processing 
is possible by the programs dpiv and dpiv3C. 

The resulting pair of 2-C PIV data sets (or files) is now merged into a single stereo (3-C) data 
set by taking into account the stereo viewing geometry. The geometry information can be 
supplied relatively easily using the StereoGeom module. Views of the geometrical 
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arrangement are available for three different orthogonal directions as a form of visual 
verification. Data set merging is either performed by PIVview internally or by the command-
line program stereo. 

In order to make file handling more user-friendly all information relevant for stereo PIV 
processing is contained in a common project file. This file is shared between the modules. 
Individual modules only update their specific sections. Platform-independence is guaranteed 
through the use of the netCDF data format that is also used for the data sets as well as other 
parameter files. 

Vector reconstruction in stereo PIV 
As mentioned above image pairs are first de-warped and processed for the respective view 
using standard 2-C PIV correlation processing algorithms. The resulting 2-C PIV data points 
from both views lie on a common grid but have to be combined using the local viewing 
angles. The figure below illustrates the viewing geometry in the xz-plane.  
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The system of equations given on the left comprise a once over-determined (3 unknown 
velocity components vs. 4 known displacements) and are solved in a least-squares fashion. 
The residuals of this solution are a measure of quality of the vector reconstruction. In practice 
the residuals should be below 0.5 pixel. The validation tab of the PIV configuration menu 
allows a vector validation based on these residuals. 

Enabling the Stereo Mode 
The stereo modules of PIView are enabled by selecting the menu entry File/Stereo. A check 
mark next to the option signals that PIVview is in stereo PIV mode. The Stereo menu is then 
enabled. 

Once the stereo mode is enabled certain features of standard (2-C) PIVview are disabled: 

 The calibration mode is no longer available. All calibration is now supplied through the 
PIVmap image registration module, that is, the physical grid spacing together with the 
mapping coefficients define the image magnification factor. The origin is also defined 
through PIVmap. 

 PIV images can only be loaded if the mapping coefficients are available. This prevents 
processing of images that have not been registered with respect to each other. 

Stereo Menu Options & Toolbar 
 New project - allows a step-by-step creation of a new stereo project using the 

StereoWizard program including the image reconstruction (back-projection) procedure. 
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 Open project - opens an existing stereo project. It loads previously calculated projection 
coefficients, the viewing geometry, the calibration images used by PIVmap as well as 
previously loaded PIV images (if available). 

 Save project - saves the current stereo configuration (coefficents, geometry & parameters) 
in the current file name. 

 Save as -  allows the stereo configuration to be stored under a different name. 

 Recent projects - allows the selection of one of the (4) most recently accessed stereo 
projects. 

 Geometry - opens the stereo geometry definition window (module StereoGeom). It is here 
where the camera position with respect to the viewing area (light sheet) is specified. 

 Image registration - opens the PIVmap module which is used for determining the back-
projection coefficients. 

 Show Image A - displays the image as viewed from camera A (if loaded). If the data has 
been processed, the image will be overlaid with the corresponding (2-C) vector or contour 
map(s). 

 Show Image B - displays the image as viewed from camera B (if loaded). 

 Show combined data - displays the reconstructed 3-C data if available. 
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Creating a new stereo project with PIVmap3 
The menu entry Stereo/Image Registration calls up the program PIVmap3 which allows a 
step-by-step calibration of a stereo PIV configuration including the grid registration 
procedure.  

Background on Stereo PIV 
Most planar imaging techniques require some sort of calibration to associate image 
coordinates with physical coordinates. A viewing arrangement in which the object plane (e.g. 
laser light-sheet) is parallel to the image plane (co-planar arrangement) involves a simple 
linear transformation consisting of translation, scaling and possibly rotation. This is no longer 
the case for oblique viewing arrangements or if lens distortion is present. In effect the co-
planar (on-axis) viewing arrangement should be considered as a special case of the oblique 
viewing arrangement. The calibration procedure for the more generalized oblique viewing 
arrangement typically requires high order mapping functions to transform image pixels to 
physical space coordinates.  

Another calibration step is necessary for multi-component measurements such as DGV or 
stereoscopic PIV. In this case the positions of the cameras with respect to the image plane 
are required. The most pragmatic approach is a direct measurement of the camera positions 
with respect to the object plane (Willert, 1997) which is not necessarily trivial in complex 
geometries involving windows or change of media (i.e. air-water interface).  

Soloff et al. (1997) introduced a mathematical formalism that combines back-projection and 
reconstruction in a single step. The procedure requires multiple images of the calibration 
target as it is translated at known displacements along the Z-axis (typical 5-7 recordings). 
The drawback of this approach is that the camera position is not retrieved directly and 
therefore unsuited for DGV. In effect the resulting projection equations connect object 
volume coordinates with planar image coordinates thus simplifying the vector reconstruction 
in stereo-PIV.  

A third approach to camera calibration originates from the field of photogrammetry and image 
vision. Common here is the use of a pin-hole camera model with added parameters to 
account for radial distortions as suggested by Tsai (1986). The calibration procedure involves 
a so-called bundle adjustment of object-space calibrated feature points using a least squares 
method. In practice this can be achieved by translation of the target as in the previous case. 
More general approaches can even calibrate on sequences of randomly oriented target 
recordings. The major drawback of this method is that the camera parameters – so called 
internal parameters – such as pixel pitch need to be specified. Specification of these intrinsic 
parameters is especially difficult when imaging fiber bundles are used. Also this model does 
not seem to account for distortions introduced by tilting of the back-plane (Scheimpflug angle 
adjustment in stereoscopic PIV). In addition to the estimated camera position the Tsai 
camera model also yields distortion coefficients and estimated lens focal length which are not 
necessarily of direct interest in image coordinate calibration.  

A slightly different approach to camera calibration is described in the following and has been 
implemented in the PIVmap3 program. The basic aim is to provide an accurate image 
mapping to de-warp images on the hand as well as to retrieve the position for each individual 
camera without knowledge of the camera characteristics as in the pinhole camera model (i.e. 
pixel pitch, lens focal length). The image mapping function is calculated from a single 
recording of a calibration target that is placed in the object plane. The target should contain a 
known pattern such as a rectangular grid of lines, dots or crosses as shown in figure 4.  

Calibration of the camera position is also based on an image series of the Z-translated 
targets as proposed by Soloff et al. (1997). The approach followed here is to use a functional 
relationship between the out-of-plane displacement and associated in-plane displacements 
to estimate the camera position. In practice, this involves solving the projection equations for 
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the point at which the image coordinates (xi,yi) vanish. With the object coordinates (xo, yo, zo) 
and image coordinates (xi,yi) the first order projection equations are: 
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Although these equations do not include higher order distortions, they nonetheless are 
sufficient for most PIV applications and show deviations on the order of 1/10th of degree with 
respect to the more precise pinhole camera model by Tsai (1986). These higher order 
methods are also included in PIVmap3. 
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Light sheet plane
= object plane
at z = 0

image plane
= CCD sensor  
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z

Light sheet plane
= object plane
at z = 0

image plane
= CCD sensor  

Figure 1: Coordinate system and viewing arrangements. Left: co-planar viewing arrangement 
with object plane parallel to image plane. Right: non co-planar (off-axis) arrangement with 
image plane tilted with respect to object plane. 

 
a) Grid imaged without 

distortions on co-planar 
arrangement 

b) Grid imaged obliquely in a 
non co-planar arrangement 

c) Grid imaged with strong lens 
distortion 

   
Figure 2: Examples of imaged grid under different viewing arrangements. 
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Figure 3: Multiple plane calibration procedure based on translation of calibration target. 
Camera A and B comprise a single-sided stereo configuration. Camera A and C view the light 
sheet from two sides. Here the light sheet thickness should be accounted for. 

 

 
Figure 4: Images of various calibration targets. In all cases the camera is located to the right of 
the reference marks. 

The program PIVmap3  
This program is intended to provide accurate image-object calibration of oblique (distorted) 
camera views as well as estimate the position of the camera if a series of Z-translated 
images is available. The core of the program is an algorithm to reconstruct a regular grid 
from images of a calibration target. The following gives a brief overview of the reconstruction 
algorithm before the programs features are described in detail. 

Grid reconstruction in PIVmap 
The reconstruction of the grid itself is a three step process: 

Step 1 – Image enhancement 
A variety of filters can be used to increase contrast of the image if the following two steps fail 
to produce reliable results. 

Step 2 – Feature extraction 
This is based on correlation-based pattern matching, that is, a grid of dots is correlated with a 
template containing a single dot. Similarly a template containing a cross is used to detect a 
grid of crosses or line grid. As the correlation locks into features brighter than the 
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background, images may need to be inverted a priori. This is done automatically by 
specifying the type of target in the input menu (e.g. black dots on white background). In any 
case, the image shown in the calibration menu should contain bright features (dots, crosses 
or lines) on a dark background. (See sections below for further details.) 

Step 3 – Grid reconstruction 
This step attempts to assign physical coordinates to the detected feature points. The grid 
origin is assigned to the point closest to the origin of the manually placed helper coordinate 
axis (red and yellow arrows). The helper axes are then used to find the 4 neighboring points 
on the major axes as well as 4 neighboring diagonal grid points. The resulting group of 3x3 
points forms the basis for the reconstruction of the remainder of the grid using a predictor-
corrector approach. To allow for deviations of the grid nodes from their predicted positions a 
reconstruction tolerance is defined (given in percent).   

The reconstructed grid will have grid index coordinates assigned to the valid correspondence 
points. Points on the major axes are shown in purple while unmatched points are shown in 
orange. 

  
Reconstructed grid showing labeled grid points. 
Unmatched points are shown in orange. 

Reconstructed grid with X-axis pointing down, 
while Y-axis is pointing to left. 

General strategy on feature extraction  
The image sample size and the sampling overlap determine the detection efficiency of the 
grid. As a rule of thumb, the sample size should be near the node distance in the image. In 
general one should start with a larger sampling window. If not all grid points were found 
change to next smaller sample or increase sample overlap. If grid points were detected more 
than once increase the merging radius to combine neighboring points. Depending on the 
tolerance the grid reconstruction procedure may ignore these misaligned calibration points.  

Effect of sample size on dot detection 
The following images illustrate the effect on sample size on the feature extraction. Detected 
dots are labeled with a cross.  
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Sample size 128x128, 80% Overlap 

 only half the dots detected 
Sample size 96x96, 80% Overlap 

 only about 70% of the dots are detected 

  
Sample size 64x64, 80% Overlap 

 all dots found, ideal parameter setting 
Sample size 48x48, 80% Overlap 

 some dots detected twice (resolved by 
increase of merging radius) 

Calculation of the mapping function 
Once the grid is reconstructed the image mapping function may be calculated. The mapping 
is a combination of two separate steps as shown in the figure below 

Image space
xi, yi

Mapped image space
xm, ym

Object space
(physical coordinates)

xo, yo, zo

Mapping via polynomial 
or ratio of polynomials

Linear transformation using 
magnification and offset

Image space
xi, yi

Mapped image space
xm, ym

Object space
(physical coordinates)

xo, yo, zo

Mapping via polynomial 
or ratio of polynomials

Linear transformation using 
magnification and offset

 
The first mapping serves to de-warp the image to reconstruct the image space onto a 
Cartesian grid. At this point the image axes are parallel to the axes in physical space. The 
second step merely applies a linear transformation to convert from image space to physical 
space. 

Mapping from image recording to reconstructed image 
A variety of mapping functions are available for the first mapping step: 

 polynomials up to degree 4 
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 projection equations, a ratio of polynomials (1st ÷ 1st, 1st ÷ 2nd, 2nd ÷ 1st, 2nd ÷ 2nd) 
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The choice of function depends on the degree of distortion in the image. In general, if the grid 
consists of straight lines a ratio of first order polynomials should be favored. However 
convergence of the polynomial ratios is not always guaranteed. Table 1 gives an overview of 
the associated number of coefficients and the required number of calibration points. If the 
number of calibration points exceeds the minimum count a standard least squares fit is used 
to calculate the coefficients for the polynomial mapping functions; a Levenberg-Marquardt 
nonlinear least squares fit is used in the calculation of the polynomial ratios. 

Table 1.: Mapping functions and their coefficients. 
Mapping function Number of coefficients Minimum number of 

calibration points 
Polynomial, 1st Order 6 3 
Polynomial, 2nd Order 12 6 
Polynomial, 3rd Order 20 10 
Polynomial, 4th Order 30 15 
Ratio, 1st ÷ 1st 8 4 
Ratio, 1st ÷ 2nd  11 6 
Ratio, 2nd ÷ 1st 14 7 
Ratio, 2nd ÷ 2nd 17 9 

Mapping from reconstructed image to object space  
Mapping between the reconstructed image and physical space is described by the following 
linear transformation: 
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where the magnification M is given in [pixel/mm] 

PIVmap3 Input Menu 
The main menu – shown Figure 5 – consists of two input areas: The left area is used to 
specify parameters that are common to all camera views and/or all image planes. The right 
area is specific to each supplied calibration image which is referred to here as plane.  
In the Global Settings area the following parameters are specified: 
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Configuration data file 
stores a summary of all 
parameter settings within the 
current instance of the program. 
The load function can retrieve 
previous parameter settings. The 
parameter files are ASCII 
formatted and may be edited with 
any text editor. 

Type of target 
specifies whether the images of 
the calibration target contain dots, 
crosses and lines. Further the 
image characteristics with respect 
to features (black-on-white or 
white-on-black) are specified 
here. This may be specific for 
each individual view. 

 

 

 
Figure 5: Main input menu of program PIVmap 

Number of views 
allows up to 4 camera views. Stereoscopic PIV would require only 2 views. A triple 
camera DGV-setup would require 3 views. A single camera view could be used to 
calibrate a standard 2-C PIV experiment. 

Z-translated images 
determines the number of calibration images for each view. At least two are required 
if the camera position is to be determined.  

Grid Spacing on target 
determines the physical distance of the calibration points on the target. 

Output Image Size 
specifies the image size of the reconstructed (de-warped) image. This parameter is 
common to all camera views. 

Calibration input area  

Load (Images) 
permits the simultaneous selection of all calibration images associated with this 
camera view. The common directory of these files is specified above the table.  

Table Area 
The table itself lists the image files, their position in Z and the specified reference 
plane. Clicking on the image file shows a preview of the corresponding image in the 
area below the table. The out-of-plane translation (Z-position) of each image can be 
entered directly in the corresponding cell. The reference plane indicates that the 
camera position and image mapping is calculated with respect to the given image and 
is set by clicking on the corresponding cell. Single images can be loaded by clicking 
the icon on the far right of the table. 

Mask image 
can be used to mask out areas in the calibration images to improve grid 
reconstruction performance and also increase overall calculation speed (less 
correlations required). Mask inversion disables the complementary area. A common 
mask is used for all images of a single view. 
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PIVmap3 Calibration Area 
Once a sequence of images has been loaded they may be displayed one-by-one in the 
calibration menu. The display should display the image with bright features (dots, crosses) 
on a dark background. If not, then the image type was not properly set in the main menu (i.e. 
black-on-white vs. white-on-black). Also any optional filtering that has been applied to the 
image will be made visible here. The image will be overlaid with a pair of coordinate axis, 
herein referred to as Helper Axis. These may be adjusted with the mouse and serve to define 
the principle directions in the grid. Details on this are given in the following section. 

The calibration area is accompanied by a tab-menu containing the tabs Filters, Scan, Scale 
and Map. Their purpose is described in the following. 

 
Figure 6: Calibration view of program PIVmap3 with Filters Menu shown. 

Filters Tab 
To improve the feature detection several filters may applied to the image. They are shown 
top-down in the order of their application. 

Median Filter 
applies median filtering on the image. Either a 3x3 or 5x5 kernel may be used. 

Histogram Equalization 
performs histogram equalization on the image. 

High-Pass Filter 
applies a Gaussian-weighted high-pass filter to the image. The width of the Gaussian 
filter function can be specified. Values between 3 and 10 are recommended. The 
processing speed decreases with increased width of the weight function. 

Binarize 
converts the image to contain only black (0) or white (255) pixels by setting values 
above the specified threshold to 255. Lower values are set to 0. 

Low-Pass Filter 
applies a Gaussian weighted smoothing filter to the image. In combination with the 
high-pass filter the resulting image will be band-pass filtered. Recommended kernel 
widths are the range of 0.5 – 1.5 pixels.  

Scan Tab  
Feature extraction in PIVmap3 is based on a correlation approach in which a template of 
either a dot or cross is matched locally to the image. The position of best match indicates the 
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center of the dot or cross in the locally sampled area. The performance of this matching 
process depends on the choice of sample size, sampling overlap and a few more parameters 
that are set in this tab. 

Spot/Template radius 
specifies the radial dimension of the dot or cross in the 
template.  

Sample size 
provides a choice of image sampling areas. Typically 
this size should roughly correspond to the mean 
spacing of the features to be extracted. 

Sample overlap 
specifies the image sampling distance. A higher 
sampling rate increases the overall performance but 
decreases processing speed. 

Minimum count 
As each sample produces an estimate of a feature 
point location, adjoining samples will detect the same 
feature point more than once. This value specifies the 
minimum number of times a feature point needs to be 
detected to qualify as such. The merging radius given 
below has a direct influence. 

Merging radius 
specifies the scan area to combine near-by feature 
point estimates. Values between 3 and 10 are 
recommended. 

Reconstruction tolerance 
is required to reconstruct the grid from the detected feature points. The reconstruction 
is based on a predictor-corrector approach where valid grid points are used to 
estimate the position of neighboring grid points. The search area is determined by 
this tolerance value. Values between 5 and 10 percent are recommended. 

Arrow tips mark neighboring points 
is used to aid the reconstruction algorithm in finding the first points near the origin. 

Limit range of nodes 
restricts the range of nodes in the reconstructed grid. This is useful if the image has 
many invalid feature points on the edges. The use of a mask (specified in the main 
menu) should however be favored. Circular or elliptic calibration geometries can be 
treated as well. 

Edit/move points manually 
In some cases the grid reconstruction may fail, if falsely detected or missing feature 
points near the grid origin mislead the reconstruction. By manually moving these 
points the grid may be properly reconstructed nonetheless. However, these 
movements are lost if the scan operation is repeated. 

Scan 
performs the feature extraction scan by the localized template matching scheme 
using the current parameter settings. Any manual change to previously detected 
feature points are lost. 

Build grid 
tries to reconstruct the grid using the currently detected feature points. 
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Scale Tab 
Dot Spacing 

specifies the actual spacing of the grid points. This 
value is set in the main input menu of the program and 
cannot be changed here. 

Global physical offset 
assigns the coordinates of the calibration origin in 
physical space. Initially this value is zero and should be 
set according to the experiment’s reference frame. 

Camera position  
reflects the camera’s position with respect to the origin 
of the grid in the specified reference plane (set in main 
menu). These values are irrespective of the global 
physical offset. 

Estimate 
tries to calculate the camera position using at least two 
calibrated planes. A valid image mapping (see Map) is 
required. The result, even for non-convergence is 
placed in the edit boxes above. 
Various estimation schemes are available, some of 
which require additional input regarding the type of 
camera (sensor) with which the images were acquired. 

Map Tab 
Parameters specified in this menu determine image mapping coefficients that perform the 
back-projection from camera view to an un-distorted image. The choice of mapping function 
is specified on the top of this menu. 

Magnification 
determines the final magnification factor for the 
reconstructed image. This value is constant throughout 
the image. 

Translate image 
By default the origin of the grid will be shifted to the lower-
left corner. These parameters allow the origin to be 
shifted. 

Copy to all views 
copies the current parameters to the remaining camera 
views. This is especially of interest when all reconstructed 
views should coincide after mapping them.  

Fit to output image 
is useful to approximately match the reconstructed grid to the specified output image 
size and should be used on a new set of calibration images. An even better match is 
achieved by manually fine tuning the magnification and shift parameters. 

Dewarp this view 
calculates the mapping coefficients for each reconstructed grid of this camera view. 
These mappings are used to back-project the original images which are then 
displayed. The overall speed of the mapping process depends on the output image 
size and the number of reconstructed planes. 
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Helper axis 
Reconstruction of the grid is based on the a priori knowledge of the direction of the major 
axes as well as an approximate location of the origin. This is achieved by manually 
specifying a pair of helper axes for each calibration image. The figures below show how 
these axes may be placed in the image using the mouse. The tips of each axis should be 
placed on the points neighboring the origin to allow a more efficient grid reconstruction. 

The function ‘Copy helper axis’ can be used to copy the coordinates from the previous plane 
to the currently displayed plane. This speeds up positioning over many calibration images. 

 
Position of axes at beginning Dragging the X-axis to the origin. Alignment of Y-axis and arrow 

tips. 
Figure 6: Manual positioning of the helper axis in the image. 

Description of the PIVmap3 menu entries 
 File/New 

creates a new PIVmap3 project. All previously loaded images are removed and 
file names are reset. 

 File/Open… 
loads a previously created PIVmap3 project. All current settings are lost. 
File/Save 
stores the current selection of image and parameters in a user-specified project 
file. This ASCII file is editable with any text editor (i.e. Notepad). The default 
extension is ‘map’. 

 File/Save 
stores the current selection of image and parameters in a user-specified project 
file. This ASCII file is editable with any text editor (i.e. Notepad). The default 
extension is ‘map’. 

 File/Exit 
leaves the program after asking the user for confirmation. 

Menu View 
 
 

View/Zoom out/in – changes the image display scale factor 

 View/Brighter – increases the image brightness on the screen (Short-cut key: B). 

 View/Darker – decreases the image brightness on the screen (Short-cut key: D). 

 View/Auto-scale – sets default intensity on image 

 View/Change color LUT – skips to the next available lookup table (LUT) to convert 
the grayscale images to pseudo-color. 
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Menu Mapping 
 Mapping/Input menu 

changes to the main input area of the program 

 Mapping/Calibration mode 
changes to the calibration area and displays the filtered image of the currently 
selected view and plane. 

 Mapping/Scan image 
performs the feature extraction scan by the localized template matching scheme 
using the current parameter settings. Any manual change to previously detected 
feature points are lost. 

 Mapping/Create grid 
tries to reconstruct the grid using the currently detected feature points. 

 Mapping/Show mapped image 
calculates the mapping coefficients for each reconstructed grid of this camera 
view. These mappings are used to back-project the original images which are 
then displayed. The overall speed of the mapping process depends on the 
output image size and the number reconstructed planes. 

 Mapping/Process current view 
performs grid reconstruction and image back-projection for all images in the 
currently selected camera view. 

 Mapping/Overlay mapped images 
computes a combined image of all available back-projected views for the 
currently selected image plane. At least two valid (back-projected) camera 
views are required. This is especially useful to check the coincidence of the 
back-projections. 

 Mapping/Process all images 
processes all images for all views including camera position estimation 

 Mapping/Center helper axis 
This utility re-centers the helper axis to the middle of the image. 

 Mapping/Copy helper axis 
This utility copies the helper axis from the previous plane to the current plane. 

 Mapping/Estimate camera position 
tries to calculate the camera position using at least two calibrated planes of the 
current view. A valid image mapping is required. The result, even for non-
convergence is placed in the calibration tab menu. 

 Mapping/Save calibration points 
exports the detected and validated feature points for all available plane of the 
current view to a user-specified ASCII file. 

 Mapping/Export for PIVview 
stores the current image projection coefficients along with all relevant data (i.e. 
image size, camera positions, etc.) in a user-specified PIVview3C project file. If 
an existing file is selected the new data is merged into it. 

Menu Tools 
 Tools/Batch image dewarping 

opens a menu allowing a series of images to be back-projected using the 
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current image maps. The image interpolation function and destination directory 
may be specified. 

 Tools/Show log 
opens a window with past error messages, warnings and comments. 
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Creating a new stereo project with StereoWizard 
The menu entry Stereo/New project calls up the program StereoWizard which allows a step-
by-step definition of a stereo projection including the grid registration procedure.  

Step 1 - Calibration image 
Here the user is asked to either load a pair of 
calibration grid images or an existing project 
he wishes to modify. 

 

 
Step 2 - Calib.Image - Basic Information 
Using the dropdown entries give the actual 
(physical) spacing of the line in the grid (here 
2 mm). Later the actual magnification factor 
is calculated from this. 

Also, some information regarding the image 
type needs to be given. For proper grid 
detection it is important for the program to 
know whether the image contains dark lines 
on a bright background or bright lines on a 
dark background. 

 
Step 3 - Calibration Images – Orientation 
In case the image needs to be flipped in 
some way (mirror view), this can be 
achieved here. 
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Step 4 - Set Reference Point 
The buttons Display A and Display B show 
the currently loaded grid image. Using the 
mouse the position of the origin can be 
selected. The grid detection algorithm later 
snaps to the nearest grid crossing. 

 

 
Step 5 - Camera Positions 
This dialog allows the user to enter the 
positions of the camera with respect to the 
origin. In addition the physical (offset) 
coordinates of the reference point may be 
specified. Alternatively the StereoGeom 
program can be used to enter the 
coordinates. 

 

 
Step 6 - Save Project 
Finally the project must be given a name and 
is saved at the chosen location. 

To begin with the actual grid detection, start 
the PIVmap module by pressing the button. 
The next steps show how the grid is 
recovered and the projection coefficients are 
determined. 

Once the wizard is closed PIVview asks the 
user whether to load the new project file into 
PIVview3C. 

Parameters such as the camera positions 
may be modified at a later stage from within 
PIVview3C.  

 



58 PIVview User Manual
 

 

StereoGeom - Geometry Definition 
This stereo module is used to define the stereo viewing arrangement, namely the camera 
positions with respect to the light sheet. The entered coordinates are specified with respect 
to the same same reference point used by the PIVmap module. Please note that in current 
implementation of PIVview the z=0 plane always defines the light sheet plane, that is, the X 
and Y-axis lie in the light sheet, while the Z-axis points normal to this plane. 

The camera positions can be entered directly in the fields on the right hand side. The 
positions within the geometry plot are updated immediately and give the user a visual 
feedback. 

 These tool buttons allow the user to view the stereo geometry from three major 
(orthogonal) directions. 

The Apply button is used to transfer the settings to PIVview such that the reconstruction of 
the 3-C velocity map is repeated using the new settings. 

StereoGeom may also be used in stand-alone fashion. In this case a file menu allows the 
user to load or save existing stereo project files. 

 
StereoCfg module showing XZ-projection of the camera / light-sheet geometry. In this example 
the cameras are placed on either side of the light sheet. 
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PIVmapT01 - Projection Module 
This module is a semi-automated procedure for determining the image back-projection 
coefficients that are necessary for stereo PIV processing. For input it requires images of a 
calibration grid (see notes below) for each camera view. The grid reconstruction process can 
be split up into three major steps - the coefficient calculation tab dialog follows these steps. 

Step1: Line detection is performed by 
interrogating image locally using the 
Hough transform which transforms the 
image intensity distribution into a polar 
coordinate space. Since straight lines 
show up as distinct bright spots in this 
transformation line segments are 
detected for each interrogation area.  

Step 2: The line segments are 
subsequently assembled into sets of 
continuous lines spanning the entire 
image. Separation into two major 
directions as well as sorting of the lines 
are then performed to reconstruct a 
grid (meshing). In order to properly 
overlay the images, the origin can be 
shifted in grid intervals using a desired 
point of reference in the calibration 
grid. 

Step 3: At this point the projection 
coefficients can be calculated using a 
desired magnification factor for the 
back-projected image. 

 

CALIBRATION GRIDS
Camera A Camera B

PIVmap (T01)
Interactive tool for determining

dewarping coefficients

IN IN

OUT OUT

I/O

Project File

Dewarping
coefficients

for
Camera A

Dewarping
coefficients

for
Camera B

(*.cfg)
to store/
restore
config.

INPUT

OUTPUT

 

For more information about this module please consult the paper by Ehrenfried (2001). 

Some notes on obtaining calibration grid images 
 The grid must be made up of two sets of continuous, evenly spaced, parallel lines that are 
orthogonal to each other.  The grid should either have bright lines on a dark background or 
dark (black) lines on a bright (white) background. The latter lends it self especially well to be 
printed by a laser printer. The grid should be aligned parallel with the light sheet of cover the 
entire field of view (if possible). The grid image should contain 10-30 lines in each dimension 
(roughly 30-60 pixel spacing) - this results in 100 to 1000 grid crossings. 

Misalignment of the grid with respect to the light sheet may increase the measurement error. 
Reference marks placed on the grid allow doubtless identification of image orientation and 
also help in obtaining an image-object space referencing. 

Important: Make sure to check the invert option in case your image has dark lines on a 
bright background. Otherwise PIVmapT01 will not be able to properly detect the grid lines. 
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PIVmapT01 Toolbars & Menu Options 
 File/Load image - opens a file dialog for loading new calibration images. 

 File/Load project - opens and loads an existing project. 

 File/Save project - save current project. 

 Tools/Place origin - allows rough placement of the origin using the cursor. The grid detection 
set the origin to the line crossing closest to this point. 

 Tools/Complete evaluation - performs full reconstruction on loaded image(s) using current 
parameter settings. 

 Tools/Line detection - performs line detection on current image using the current Hough 
transform processing parameters. 

 Tools/Form mesh - tries to reconstruct the mesh from the detected set of lines. 

 Tools/Reconstruct grid - detects the line crossing in the mesh and determines the major 
axis. 

 Tools/Find optimal map - provides an initial guess for the back-projected image by trying to 
keep the magnification factors near unity. Fine tuning is possible with by changing the 
parameters in the Projection tab of the parameters. 

 Tools/Eval. parameters - opens a tab dialog that allows step-by-step processing of the grid 
images. 

 Tools/Show Info - gives information about the status of PIVmap. 

 Tools/Measure - places a ruler into the image allows the user to measure distances between 
two points. 

 Tools/Set ROI - allows interactive definition of a region of interest in which grid detection is 
to be performed. 

 Tools/Elliptic ROI - toggles the ROI shape between rectangular and elliptic. 

 Tools/Best fit ROI - maximizes the ROI to fit the image size. 

 View/Show Grid A - displays the calibration image for camera view A. 

 View/Show Grid B - displays the calibration image for camera view B. 

 View/Back-projected image(s) - dewarps the loaded calibration images using the current 
sets of projection coefficients (if avaiable). 

 The View menu has a number of entries that are identical to those found in PIVview: zoom 
functionality, image brightness, etc. 
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Main window of PIVmapT01 showing calibration image overlaid with reconstructed grid. Red 
crossings indicate the major axis. The origin itself is marked by the yellow circle. Note that the 
image is a negative of the original which consists of dark lines on a bright background. 

PIVmapT01 Tab Dialog 
The tab dialog is accessed with the button  and is split into an upper portion giving 
feedback on the current status of PIVmapT01 such as which image is available and 
displayed or whether grid reconstruction has been successful. The lower tab dialog 
(described below) follows the main processing steps of PIVmapT01.  

The buttons A and B toggle the display between images A and B. The parameters in the first 
two tabs are unique to each image a change accordingly. The Projection-tab parameters are 
identical for both images. 

The Go-Button starts a complete processing of the loaded images using the current 
parameter settings. If successful the mapped image pair is displayed in the main window. 
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PIVmapT01 Dialog - Detect Lines 
This tab is devoted to the line detection portion of T01 
based on the Hough transform. The following 
parameters can be set: 

Pixel threshold - threshold for pixels to be used in 
the Hough transform.  
High value = less lines, but faster.  
Low value = more lines, slower. 

Line threshold - threshold for detection of the 
maximum in the Hough plane. 
High value = less lines, 
low value = more lines.  

Filter size - kernel size of filter for smoothing the 
Hough transform  
(Can normally be set to 1, e.g. no filtering) 

Scan size theta - angular increment used during 
maximum search. Default of 5 usually does not 
need to be altered. 

Scan size radius - radius increment used during 
maximum search. Default of 5 usually does not 
need to be altered.  

Window size - size of the sampling window used in the Hough transform. Its size should be 
larger than the typically distance between two grid lines. This window size also defines 
the length of the individual line segments. In case of strongly curved grid lines the 
window size should not be chosen to be too large which might impede the accuracy. 

Window step - sampling distance between Hough interrogation windows. This distance 
should be smaller than the window size to ensure overlapping line segments.  
Small value = slower, but high accuracy 
High value = faster, less precise. 

Image desampling – down-samples the image to speed up processing at the price of 
slightly reduced precision - especially useful during optimization of line detection 
parameters. 

Invert - turns loaded image into its negative. The Hough line detection algorithm requires 
bright line data on a dark background. 

Detect lines button – starts the detection algorithm. This process is the most lengthy step in 
the grid reconstruction process but can be aborted at any point, available line segments 
are displayed. 
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PIVmapT01 Dialog – Mesh & Map 
This dialog contains all parameters necessary for reconstruction of the grid from the 
previously detected line segments. 

Form mesh button - connects line segments to form 
continuous grid lines, The result is displayed by 
overlaying the image with green lines. 

Mapping button - calculates the back-projection 
(mapping) coefficents. 

Scan size image - search distance between 
neighboring line segments. Default of 5 usually 
does not need to be altered. 

Theta tolerance - maximum possible angle (degrees) 
allowed between two neighboring line segments. 
For strongly curved grid lines this value may need 
to be increased (default = 5°). 

Minimum count - minimum number of line segments 
necessary to form a grid line; 
high value = less short lines, less chance of outlier 
lines, 
low value = permits more short lines. 
In case of outlier lines just increase this value. 

Base angle - defines the principle direction of the X-
axis. An angle of 0° corresponds to having the X-
axis run horizontal from left to right. In case of 
diagonal lines choose a value of either +45° or - 
45°.  

 

Horiz. Shift - shifts the vertical (Y) axis horizontally across the image. Defines the horizontal 
coordinate of the image origin. 

Vert. Shift - shift the horizontal (X) axis vertically across the image starting from the bottom. 
Defines the vertical coordinate of the origin. 

Flip L-R - flips the image left-to-right. Useful in case of using mirrors or viewing the light 
sheet from two different sides. 

Flip T-B - flip the image top-to-bottom. 

Iterations - maximum number of iterations used for the calculation of the coefficients; 
low value = faster, higher chance of result not being converged, 
high value = slower, better chance of convergence. 

1st Order - sets mapping function to be a ratio of polynomials of first order. 

Mix: 2nd/0th - mapping function only a second order polynomial (divisor is unity). 

Mix: 2nd/1th - mapping function = ratio of 2nd order polynomial and first order polynomial 
(divisor). 

2nd Order - mapping function = ratio of two second order polynomials.  
Note: higher order mapping functions may result in more precision but may require more iteration steps. 
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PIVmapT01 Dialog – Projection 
This dialog is used to set the image size of the back-projected images. 

Calculate button - calculates back-projected images 
which are displayed in the main window of 
PIVmap. The images a overlaid with each other. 

Only A - calculates back-projected image only for view 
A. 

Only B - calculates back-projected image only for view 
B. 

Origin ox/oy - x-, y-coordinates (pixel) of the image 
origin within the back-projected image. 

Grid spacing x, y [pixel] - distance between grid lines 
in the back-projected image. This value should 
chosen to be close to the line spacing in the 
original images.  

Grid spacing x, y [mm] - distance between grid lines in 
physical space. The ratio of this value and the 
pixel grid spacing gives the image magnification 
factor (also shown in dialog). 

Image Size x,y - pixel dimensions of the resulting 
image which is shown as a red box in the main 
window. 
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Stereo View Disparity Correction 
In practice it generally is not possible to perfectly align the calibration target with the light 
sheet. As a result the sampling windows of the PIV interrogation do not coincide between the 
two views. One way to account for this is to perform a PIV correlation analysis on the particle 
images acquired at the same instant from the two views, that is, correlating an image from 
view A with an image from view B. This correlation results in a vector map showing the 
misalignment between the two camera views. This disparity (misalignment) map can then be 
used to adjust the projection coefficients. 

PIVview3C offers this alignment procedure in the Stereo Menu entry Disparity Correction1, 
which opens the window shown on the right (provided a stereo project and image set has 
been loaded).  

The alignment window shows an overlayed image of the two camera views. The mouse can 
be used to interactively correlation-probe the image, similar to the main PIVview window. 

Main window of the PIVview3C stereo 
camera disparity correction. 

Displacement vector map showing the 
misalignment between the camera views. 

Disparity Correction Tool Buttons: 
The functions of the view tool buttons are equivalent to those of other views so only those 
unique to this window are described here. 

 shows the correlation plane window for interactive image probing. 

 opens the configuration menu shown to the right of image view. 

 performs a full interrogation of the image pair followed by data validation. The result is 
displayed as a green vector map. 

 applies a least squares fit to the validated data and displays a red vector map of the fit. 

 saves the coefficients of the current least squares fit and prompts the user whether to enable 
the fit in which case PIVview reloads the image set with modified projection coefficients. 

 Once the alignment map has been activated this window can be used to verify the actual 
alignment. Further alignment iterations are not possible. 

 

                                                 
1 In earlier versions of PIVview the misalignment correction between the camera views was referred to 
as residual alignment. 
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Some notes on performance: 
In some instances the particle images viewed by one camera are only weakly distinguishable 
on the other. This is frequently the case for air flows seeded with small particles utilizing a 
forward-backward scattering arrangement. For this reason rather larger interrogation 
windows are necessary. When in doubt, we suggest increasing the interrogation window until 
consistent displacement fields are produced. The correlation plane window is also useful for 
this optimization. 

The correlation module of alignment procedure actually makes use of all four images of a 
stereo PIV recording and uses a multiplication of correlation planes to enhance the 
correlation peak. 

The alignment procedure allows a choice on which of the two projection maps are modified; 
the default is a symmetric adjustment of both views. 

 
Disparity correction window after least-squares fit to offset data. 

 



PIVview User Manual 67
 

Command-Line Utility Programs 
The PIVview program suite includes several command-line based utility programs that can 
be used for batch processing purposes, debugging, data retrieval, etc. These programs 
should be run from the command shell (e.g. DOS-box), and their path (.\PIVview\Bin\ or 
.\PIVview\Utils\ ) should be added to the system’s PATH variable. 

These program are useful for batch processing large amounts of PIV-images without using 
PIVview itself (frequently done on Linux/Unix systems). 

AVERAGE  
This program first builds a list of files from the first and last file provided and then calculates 
statistics from these. The result is placed in a new file whose name is determined from the 
common file stub of the input files. It is useful in the calculation of quantities such as mean 
velocity field or Reynolds stresses. 
Calling procedure:  
 average <dataIN_1> <dataIN_N> 

Parameter description  
<dataIN_1> (input) first file in sequences to be processed.  

<dataIN_N> (input) last file in sequences to be processed.  

Command line options  
-prefix<stub> overrides the output file stub to the name provided  

-rms also stores the RMS data in a separate file  

-reyn computes Reynolds stresses from velocity data  

-fluct computes fluctuations by removing mean from each data set  

-info provides feedback during processing of data  

-tec store result in Tecplot ASCII file 

-plt store result in Tecplot binary file.   

DPIV  
The program dpiv reads the specified image(s) and parameter file and then performs 
complete PIV processing including:  

 image pre-processing (filtering, background subtraction, etc.)  

 correlation analysis (particle image shift extraction)  

 data validation  

 conversion to velocity or physical shift  

The result is stored in a netCDF file such that it can be read by other PIVview programs. Use 
ncdf2tec to convert the data to a Tecplot-readable format. Unless specified with the -o option 
the output file name is determined from the image name. 

Calling procedure:  
 dpiv <par_file> <imageA> <imageB>  

Parameter description  
<par_file> (input) PIVview generated parameter or data file (netCDF-format) with 
processing information.  
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<imageA> (input) PIV or speckle image  

<imageB> (input) Second image of pair (if required)  

Command line options  
-def performs second-order accurate image deformation PIV  

-mg performs multigrid (pyramid) PIV 

-auto  perform autocorrelation processing; only one image is required.  

-noflip  avoids flipping or rotating the image (important for stereo-PIV processing)  

-noip  avoids image pre-processing options   

-norotate  avoids flipping or rotating the image (important for stereo-PIV processing)  

-info  provides feedback during processing of data  

-o<fname>  stores output data in file <fname>  

-pco  treats the input image as a PCO-double exposure image  

-speckle  perform speckle shift processing, where the first image is considered the 
reference (unshifted) image.  

-wx|y  specifies the interrogation window size. Overrides the value specified in the 
parameter file. 

-sx|y  specifies the interrogation window step size. Overrides the value specified in 
the parameter file. 

-bx|y  specifies the global image offset.  Overrides the value specified in 

-mask<fname> uses specified mask image. Useful for batch processing with varying masks. 
Note: mask image must have the same size as PIV images. 

DPIV3C  
The program dpiv3c reads the specified stereo configuration and parameter files to perform 
complete stereo PIV processing using the given image set. This processing including:  

 image pre-processing (filtering, background subtraction, etc.)  

 image back-projection using projection maps (including disparity correction) 

 correlation analysis for both view (particle image shift extraction)  

 data validation  

 merging of the two views  

 conversion to velocity  

The result is stored in a netCDF file such that it can be read by other PIVview programs. Use 
ncdf2tec to convert the data to a Tecplot-readable format. Unless specified with the -o option 
the output file name is determined from the first image name (View A).  

Calling procedure:  
 dpiv3c <cfg_file> <imageA1> <imageA2> <imageB1> <imageB2>  

 dpiv3c –pco <cfg_file> <imageA> <imageB> 

Parameter description  
<cfg_file> (input) PIVview3C generated stereo configuration file (netCDF-format).  

<imageA?> (input) PIV image pair for view A 

<imageB?> (input) PIV image pair for view B 

Command line options  
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-align perform camera disparity correction 

-def performs second-order accurate image deformation PIV  

-mg<fact> performs multi-grid (pyramid) PIV, initial de-sampling factor <fact> 
(default=3) 

-info  provides feedback during processing of data  

-o<fname> stores output data in file <fname>  

-noip  avoids image pre-processing options   

-pco treats the input images as a PCO-double exposure image (both images must 
be PCO images) 

-wx|y  specifies the interrogation window size. Overrides the value specified in the 
parameter file. 

-sx|y  specifies the interrogation window step size. Overrides the value specified in 
the parameter file. 

-bx|y  specifies the global image offset.  Overrides the value specified in 

-mask<fname> uses specified mask image. Useful for batch processing with varying masks. 
Note: mask image must have the same size as PIV images. 



70 PIVview User Manual
 

 

IMAGEPRE  
This utility program reads the specified image and performs image pre-processing (filtering, 
background subtraction, etc.) as specified in the parameter file. 
Calling procedure:  
 imagepre <par_file> <imageIN> <imageOUT> 

Parameter description  
<par_file> (input) PIVview generated parameter or data file (netCDF-format) with image 

pre-processing information.  

<imageIN> (input) original image  

<imageOUT> (output)  pre-processed output image 

Command line options  
-noflip avoids flipping or rotating the image (important for stereo-PIV processing)  

-norotate avoids flipping or rotating the image (important for stereo-PIV processing)  

-info provides feedback during processing of data  

-pco treats the input image as a PCO-double exposure image and generates two 
output images with the extensions .ima, .imb  

-pco2 same as the -pco option, but stores the resulting image pair in a single PCO-
double expsure image file.   

NCDF2TEC  
The program reads the specified PIVview data file and generates a Tecplot-formatted ASCII 
or binary output file. 
Calling procedure:  
 ncdf2tec <fileIN> <fileOUT> 

Parameter description  
<fileIN> (input) netCDF data file as generated by PIVview 

<fileOUT> (output) Tecplot formatted output file 

Command line options  
-asc creates ASC-II data file 

-bin creates Tecplot binary data file 

-vel  writes out the velocity data contained in the input file if it is available. This is the 
default output option.  

-disp  writes out the pixel (image) displacement data contained in the input file.  

-piv  writes out the pixel (image) displacement data contained in the input file.  

-mag  also writes out either velocity magnitude or pixels shift magnitude depending on 
which option was set. 

-raw skip post-processing of data after loading (i.e. validation) 

-diff  stores differentials (implies -vel) 

-dvort  stores vorticity data (implies -vel) 

-dshear  stores shear strain data (implies -vel) 

-dnstrain stores normal strain data (implies -vel) 



PIVview User Manual 71
 

-s<num> sets output stride to <num>, that is only every <num>th point is stored.  

-sx<num> sets horizontal output stride to <num>.  

-sy<num> sets vertical output stride to <num>.  

-z stores Z-coordinate 

-z<num> stores user-specified Z-coordinate  

-info  provides feedback during processing of data 

NCDUMP  
The NCDUMP program reads the specified data file and writes the contents onto the 
command (shell) screen. 

Calling procedure:  
 ncdump <fileIN>  

Parameter Description  
<fileIN> (input) any netCDF-formatted data file  

-h (option) shows only variable and attribute definitions and their values.  

-help (option) shows all available options for ncdump.  

NCGEN  
The NCGEN program reads the specified raw CDF data file and generates a netCDF (binary) 
data file. The makes it possible to convert the ASC-II output obtained from ncdump back to 
netCDF. The resulting data file is written to the screen unless a file name is specified with the 
-o option. 

Calling procedure:  
 ncgen <fileIN>  

Parameter Description  
<fileIN>  (input) ASC-II formatted data file with variable and attribute definitions   

-o <fileOUT> (option) stores the resultant netCDF data in the specified output file. 
Otherwise data is written to stdout (screen).  

-help  (option) shows all available options for ncdump.  

POSTPROC  
This program first builds a list of files from the first and last file provided and then performs 
post-processing (i.e. validation, conversion, filtering, etc.) on each PIV displacement data set. 
The results are placed in new files whose names are determined from the common file stub 
of the input files. It is useful when only post-processing of previously calculated PIV 
displacement data is necessary. 
Calling procedure:  
 postproc <PARfile> <dataIN_1> <dataIN_N> 

Parameter description  
<PARfile> (input) first file in sequences to be processed.  

<dataIN_1> (input) first file in sequences to be processed.  

<dataIN_N> (input) last file in sequences to be processed.  

Command line options  
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-prefix<stub> overrides the output file stub to the name provided  

-A use parameters associated with camera view A, if available  

-B use parameters associated with camera view B, if available  

-info provides feedback during processing of data  

-tec store result in Tecplot ASCII file 

-plt store result in Tecplot binary file.   

STEREO  
The program reads the specified PIVview data files supplied for each camera view and 
reconstructs the 3-C velocity field using the geometry information specified in the parameter 
file. Use the StereoGeom module to specify the geometry information. 

Calling procedure:  
 stereo <CfgFile> <fileA> <fileB> <fileOut> 

Parameter Description  
<CfgFile> (input) Stereo project file as generated by PIVview3C and/or stereo modules. 

<fileA> (input) PIV data set for view A (netCDF format required)  

<fileB> (input) PIV data set for view B (netCDF format required)  

<fileOut> (output) PIV data with reconstructed 3-C velocity data (default = netCDF format).  

Command line options  
-info  (option) gives feedback during processing.  

-plt  (option) writes out the data in Tecplot-binary format. 

-tec  (option) writes out the data in Tecplot-ASCII format. 

-A use grid from <fileA> as output grid (If the grid from view B does not coincide 
then this data is interpolated) 

-B use grid from <fileB> as output grid (If the grid from view A does not coincide 
then this data is interpolated) 
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Shortcut keys in PIVview 
F2 region-of-Interest selection (if enabled) 

F4 PIV parameter menu (also with right-mouse button on image)  

F5 start PIV evaluation  

F6 show correlation plane 

F7 show 2-D scatter plot (histogram) 

F10 redraw current view 

B image brighter  

D image darker  

I show / hide image after evaluation 

L change pseudo-color look-up table  

Shift+L  show previous pseudo-color look-up table  

P open plotting parameter menu 

C show / hide scalar image after evaluation  

V show / hide vector field after evaluation 

+ increase image magnification (zoom in)  

– decrease image magnification (zoom out)  

 

CTRL+i image pre-processing menu  

CTRL+L hide / show LUT bar 

CTRL+M open mask editor 

CTRL+O open file dialog for loading images 

CTRL+P print currently displayed data or image 

CTRL+Q quit PIVview 

space-bar toggle between images of image pair 

CTRL+Space overlay images of image pair 

 

Mouse ShortCuts & Actions 
Left click on image pair  

– single-point PIV evaluation using current parameter settings. 

Right click on image pair  
– opens context-sensitive menu 

Double-click on evaluated image  
– opens a data monitoring window showing statistics for each point currently 
captured by the mouse. 
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Supported File Formats 
Supported Image Formats  
Tagged image file format (TIFF)  

at 8-bit/pixel and 1-bit/pixel including compression (Not supported are LZW-
compressed TIFF images on which Unisys holds a patent. If you plan to use 
LZW-TIFF images use a image converter such as IrfanView to convert the 
images to another supported format). Color images are converted to 8bit 
grayscale. 

Windows Bitmap (BMP) 
1, 4 and 8 -bit/pixel, color images are converted to 8-bit grayscale. 

JPEG  Color JPEG‘s are converted to 8-bit grayscale. 

Portable Network Graphics (PNG) 
Color images are converted to 8-bit grayscale. 

Portable Bitmap Graphics (PBM, PGM, PPM)  
This includes various formats from a collection of ASCII based bitmap types: 
PBM, PGM and PPM. PBM (Portable Bitmap format) is a 1-bit, black and white 
bitmap type, PGM (Portable Greymap format) is an 8-bit greyscale bitmap type 
and PPM (Portable Pixelmap format) is a 24-bit full colour bitmap. 

PCO-B16 a 16-bit/pixel image format used by PCO‘s camera acquisition software 

B32 an extension of PCO‘s B16-format to 32-bit/pixel 

LaVision Images (IMG) 
a 16-bit/pixel integer and 32-bit/pixel floating point image format used by 
LaVision’s DAVIS software. Not supported is LaVision‘s proprietary, 
compressed IMX file format. 

Note: The command line utilities such as dpiv only support the following image formats: 

 TIFF - all except LZW-TIFF and 24-bit color 

 BMP - 1 and 8 bit/pixel, uncompressed 

 PCO-B16 

 LaVision-IMG 

Image naming and numbering conventions 
Generally PIVview automatically determines the image name of the second image using the 
name of the first. Several rules are used to determine the second image: 

ima → imb  If the first image has the extension ‘ima’ then the program will look for a file 
where the extension changed to ‘imb’ 
Example: (1st image: myImage.ima ) →  (2nd image: myImage.imb ) 

*a.* → *b.* If the first image has the letter ‘a’ before the extension then program will look for 
a file changed where ‘a’ is replaced by ‘b’ 
Example: (1st image: myImage_a.tif ) →  (2nd image: myImage_b.tif ) 

(n) → (n+1) If the images are sequentially numbered the program will look for the file with 
the next highest index. 
Example: (1st image: img099.tif ) →  (2nd image: img100.tif ) 

Excepted from these rules are images loaded in the speckle or autocorrelation modes, as 
well as images that are loaded as self-contained image pairs (e.g. PCO-B16 double images). 
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Supported Output File Formats  
ASCII Plain ASCII data can be generated by PIVview which can then be read by other 

programs without much effort. A short header specifies the number of points in 
the data set along with a description of each column‘s content.  

Tecplot  PIVview data can be exported to be compatible with the TecPlot graphics 
package (AMTEC Engineering, Inc., www.amtec.com), Version 7.0 and higher). 
Style files for both displacement and velocity data are generated to ease the 
data presentation with TecPlot.  

netCDF is a self-describing, platform-independent data file format frequently used in the 
scientific community. NetCDF data generated by PIVview is aimed to be 
compatible with the layout utilized by PivNet/EuroPIV cooperation projects.  

Since NetCDF is an open format, additional variables can be added without 
interfering with a predefined layout. Further information on NetCDF can be 
found at Unidata (www.unidata.ucar.edu).  

Two separate utilities are redistributed with PivView that allow NetCDF file 
viewing (ncdump) as well as NetCDF file generation (ncgen). In principle these 
utilities allow the user to edit a NetCDF file by first converting it to a text file with 
ncdump and recompiling it after modification using ncgen .  

Parameter Files  
The current parameter settings are generally stored in the system registry when the program 
exits. Once the program restarts these parameters are restored. However, the most 
important parameters, especially those regarding evaluation, conversion and post-processing 
can also be stored in a separate file which has the same name as the image and the 
extension .par. These files are formatted in NetCDF (see above) and are compatible with the 
existing UNIX-based PIV software of the German Aerospace Center (DLR) as well as with 
the specifications defined by the EuroPIV / PivNet activities. 
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